Aerosol Instrument Manager®
Software for Scanning Mobility
Particle Sizer™ (SMPS™)
Spectrometer

User’s Manual

P/N 1930038, Revision G
October 2006
Aerosol Instrument Manager® Software for Scanning Mobility Particle Sizer™ (SMPS™) Spectrometer

User’s Manual
Manual History

The following is a manual history of the Aerosol Instrument Manager Software for Scanning Mobility Particle Sizer™ (SMPS™) Spectrometer User’s Manual (Part Number 1930038).

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Version</td>
<td>May 2002</td>
</tr>
<tr>
<td>A</td>
<td>October 2002</td>
</tr>
<tr>
<td>B</td>
<td>May 2004</td>
</tr>
<tr>
<td>C</td>
<td>February 2005</td>
</tr>
<tr>
<td>D</td>
<td>November 2005</td>
</tr>
<tr>
<td>E</td>
<td>March 2006</td>
</tr>
<tr>
<td>F</td>
<td>April 2006</td>
</tr>
<tr>
<td>G</td>
<td>October 2006</td>
</tr>
</tbody>
</table>
Warranty

Part Number: 1930038 / Revision G / October 2006
Copyright: © TSI Incorporated / 2002–2006 / All rights reserved.
Address: TSI Incorporated / 500 Cardigan Road / Shoreview, MN 55126 / USA
Email Address: particle@tsi.com
World Wide Web Site: http://www.tsi.com/
Telephone No.: 1-800-874-2811 (USA only) or (651) 490-2811
Fax No.: (651) 490-3824

Limitation of Warranty and Liability (effective July 2000)

Seller warrants the goods sold hereunder, under normal use and service as described in the operator’s manual, shall be free from defects in workmanship and material for (12) months, or the length of time specified in the operator’s manual, from the date of shipment to the customer. This warranty period is inclusive of any statutory warranty. This limited warranty is subject to the following exclusions:

a. Hot-wire or hot-film sensors used with research anemometers, and certain other components when indicated in specifications, are warranted for 90 days from the date of shipment.

b. Parts repaired or replaced as a result of repair services are warranted to be free from defects in workmanship and material, under normal use, for 90 days from the date of shipment.

c. Seller does not provide any warranty on finished goods manufactured by others or on any fuses, batteries or other consumable materials. Only the original manufacturer’s warranty applies.

d. Unless specifically authorized in a separate writing by Seller, Seller makes no warranty with respect to, and shall have no liability in connection with, goods which are incorporated into other products or equipment, or which are modified by any person other than Seller.

The foregoing is IN LIEU OF all other warranties and is subject to the LIMITATIONS stated herein. **NO OTHER EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR PARTICULAR PURPOSE OR MERCHANTABILITY IS MADE.**

TO THE EXTENT PERMITTED BY LAW, THE EXCLUSIVE REMEDY OF THE USER OR BUYER, AND THE LIMIT OF SELLER’S LIABILITY FOR ANY AND ALL LOSSES, INJURIES, OR DAMAGES CONCERNING THE GOODS (INCLUDING CLAIMS BASED ON CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR OTHERWISE) SHALL BE THE RETURN OF GOODS TO SELLER AND THE REFUND OF THE PURCHASE PRICE, OR, AT THE OPTION OF SELLER, THE REPAIR OR REPLACEMENT OF THE GOODS. IN NO EVENT SHALL SELLER BE LIABLE FOR ANY SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES. SELLER SHALL NOT BE RESPONSIBLE FOR INSTALLATION, DISMANTLING OR REINSTALLATION COSTS OR CHARGES. No Action, regardless of form, may be brought against Seller more than 12 months after a cause of action has accrued. The goods returned under warranty to Seller’s factory shall be at Buyer’s risk of loss, and will be returned, if at all, at Seller’s risk of loss.

Buyer and all users are deemed to have accepted this LIMITATION OF WARRANTY AND LIABILITY, which contains the complete and exclusive limited warranty of Seller. This LIMITATION OF WARRANTY AND LIABILITY may not be amended, modified or its terms waived, except by writing signed by an Officer of Seller.

Service Policy

Knowing that inoperative or defective instruments are as detrimental to TSI as they are to our customers, our service policy is designed to give prompt attention to any problems. If any malfunction is discovered, please contact your nearest sales office or representative, or call TSI at 1-800-874-2811 (USA) or (651) 490-2811.
1. GRANT OF LICENSE. TSI grants to you the right to use one copy of the enclosed TSI software program (the “SOFTWARE”), on a single computer. You may not network the SOFTWARE or otherwise use it on more than one computer or computer terminal at the same time.

2. COPYRIGHT. The SOFTWARE is owned by TSI and is protected by United States copyright laws and international treaty provisions. Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g., a book or musical recording) except that you may either (a) make one copy of the SOFTWARE solely for backup or archival purposes, or (b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for backup or archival purposes.

3. OTHER RESTRICTIONS. You may not rent or lease the SOFTWARE, but you may transfer the SOFTWARE and accompanying written material on a permanent basis, provided you retain no copies and the recipient agrees to the terms of this Agreement. You may not reverse-engineer, decompile, or disassemble the SOFTWARE.

4. DUAL MEDIA SOFTWARE. If the SOFTWARE package contains multiple types of media, then you may use only the media appropriate for your single-user computer. You may not use the other media on another computer or loan, rent, lease, or transfer them to another user except as part of the permanent transfer (as provided above) of all SOFTWARE and written material.

5. U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to the restrictions set forth in the “Rights in Technical Data and Computer Software” Clause at 252.227-7013 and the “Commercial Computer Software - Restricted Rights” clause at 52.227-19.

6. LIMITED WARRANTY. TSI warrants that the SOFTWARE will perform substantially in accordance with the accompanying written materials for a period of ninety (90) days from the date of receipt.

7. CUSTOMER REMEDIES. TSI’s entire liability and your exclusive remedy shall be, at TSI’s option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE that does not meet this Limited Warranty and which is returned to TSI with proof of payment. This Limited Warranty is void if failure of the SOFTWARE has resulted from accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer.

8. NO OTHER WARRANTIES. TSI disclaims all other warranties, either express or implied, including, but not limited to implied warranties of merchantability and fitness for a particular purpose, with regard to the SOFTWARE and the accompanying written materials.

9. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. In no event shall TSI be liable for any damages whatsoever (including, without limitation, special, incidental, consequential or indirect damages for personal injury, loss of business profits, business interruption, loss of information or any other pecuniary loss) arising out of the use of, or inability to use, this SOFTWARE.
Append Sample Data to an Existing SMPS File.............. 4-14
Export SMPS Data to an Access Database................... 4-15
   To Set Up the Database........................................... 4-15
   To Export Data to the Database ......................... 4-16
Database Tables......................................................... 4-17
Active Menus for an SMPS Spectrometer.................. 4-18
   File Menu............................................................... 4-19
   Run Menu................................................................ 4-23
   Playback Menu....................................................... 4-25
   Format Menu.......................................................... 4-26
   View Menu............................................................. 4-32
   Sample Menu........................................................ 4-40
   Window Menu.......................................................... 4-41
   Help Menu............................................................. 4-42
Status Bar Icons ..................................................... 4-43

APPENDIX A Data Files, Project Files, and Stored
   Parameters .......................................................... A-1
Data Files and Project Files........................................ A-1
Project File Parameters............................................... A-2
Saved Parameters ..................................................... A-3

APPENDIX B Accelerator Keys........................................ B-5

APPENDIX C Calculations Used for SMPS™ Spectrometer ... C-1

APPENDIX D SMPS™ Software Comparison .................... D-1

APPENDIX E Sequence Files ........................................... E-1
   Opening a File That is Part of a Sequence ................ E-2

APPENDIX F Error Messages............................................ F-1

APPENDIX G Scanning Mobility Particle Sizer™ (SMPS™)
   Spectrometer Diffusion Loss Correction.................. G-1
   Why Are Diffusion Losses Important in the SMPS?...... G-1
   How Can You Characterize Diffusion Losses in the SMPS? G-2
      Determination of P_1 .............................................. G-3
      Determination of P_2 .............................................. G-3
      Determination of P_3 .............................................. G-4
      Determination of P_4 .............................................. G-4
      Determination of P_5 .............................................. G-4
   How Does It Work? ................................................ G-4
   When Should I Use Diffusion Loss Correction? ....... G-6
      Ultrafine Particles.................................................. G-6
      Low Flow Rates .................................................. G-6
      Free Upgrade ...................................................... G-6
   References.................................................................. G-7

APPENDIX H Scanning Mobility Particle Sizer™ (SMPS™)
   Spectrometer Nanoparticle Aggregate Mobility
   Analysis Software Module ....................................... H-1
   Introduction............................................................. H-1
4-18 Size Data Weighted by Mass ............................................. 4-36
4-19 Statistics Table ................................................................. 4-37
4-20 Select Settings to Display SMPS Settings for the Sample .. 4-38
4-21 Sample Menu ................................................................... 4-40
4-22 Window Menu .................................................................. 4-41
4-23 Help Menu ....................................................................... 4-42
E-1 File Question? Dialog Box ................................................. E-2
G-1 Circular Tube Penetration Efficiency [Gornley and Kennedy (1949)] ................................................................. G-2
G-2 Schematic of the Component Scanning Mobility Particle Sizer Spectrometer ............................................................ G-3
G-3 SMPS Properties Box Screen of Aerosol Instrument Manager Software for the SMPS Spectrometer ................... G-5
G-4 Aerosol Instrument Manager Data file of Outdoor Air without diffusion loss correction........................................ G-6
G-5 Aerosol Instrument Manager Data file of Outdoor Air with diffusion loss correction............................................. G-6
H-1 Two Module Approach for Nanoparticle Aggregate Mobility Analysis. Courtesy: Lall, et al., 2006 c ................. H-3
H-2 Physical Properties Tab of the Aerosol Instrument Manager Software Showing the Nanoparticle Aggregate Analysis Module User Interface. ........................................ H-6
H-3 Aggregate distribution functions based on standard calibration for spheres (Red) compared with the distributions based on the idealized aggregate theory (Green). ................................................................. H-7

Tables

4-1 Descriptions for SMPS Hardware Settings Tab ................ 4-6
4-2 Descriptions for the SMPS Scheduling Tab ....................... 4-9
4-3 Descriptions of the SMPS Physical Properties Tab .......... 4-10
4-4 Descriptions for the Communications Tab ......................... 4-14
4-5 Display Options for Units ................................................. 4-33
4-6 Weight Options ............................................................... 4-35
F-1 Error Messages for SMPS Spectrometer ......................... F-1
About This Manual

Purpose

This is an instruction manual for the Aerosol Instrument Manager® Software as it applies to a TSI Scanning Mobility Particle Sizer™ (SMPS™) Spectrometer.

Related Product Literature

- Model 3934 Scanning Mobility Particle Sizer™ (SMPS™) Spectrometer manual, part number 1930081, TSI Incorporated
- Model 3936 Scanning Mobility Particle Sizer™ (SMPS™) Spectrometer manual, part number 1933796, TSI Incorporated
- Model 3980C macroMS Macroion Mobility Spectrometer manual, part number 1930110, TSI Incorporated
- Model 390069 Data Merge Software Module manual, part number 1930074, TSI Incorporated

Getting Help

To obtain assistance for this software or to submit suggestions, please contact Particle Instruments:

TSI Incorporated
500 Cardigan Road
Shoreview, MN  55126  USA
Fax:  (651) 490-3824
Telephone:  1-800-874-2811 (USA) or (651) 490-2811
E-mail:  technical.service@tsi.com
Submitting Comments

TSI values your comments and suggestions on this manual. Please use the comment sheet, on the last page of this manual, to send us your opinion on the manual’s usability, to suggest specific improvements, or to report any technical errors.

If the comment sheet has already been used, mail or fax your comments on another sheet of paper to:

TSI Incorporated
Particle Instruments
500 Cardigan Road
Shoreview, MN 55126
Fax: (651) 490-3824
E-mail Address: particle@tsi.com
CHAPTER 1

Introduction

The Aerosol Instrument Manager® software is used to collect sample data from a spectrometer and store the sample data in files. You can use the software to display data in graphs and tables, or view statistical information. You can print graphs and tables with the software, and you can export data for use in other applications, including a Microsoft® Access® database.

There are a number of ways to navigate within the program. These include selecting items from the main menus, selecting icons from the toolbar, and selecting items from submenus (which you access by right-clicking the mouse button). Specific instructions are provided in the following chapters.

The Aerosol Instrument Manager software is designed to be used with a variety of different TSI spectrometers and sensors.

- Aerodynamic Particle Sizer® (APS™) Spectrometers
- Scanning Mobility Particle Sizer™ (SMPS™) Spectrometers
- Condensation Particle Counters (CPCs)
- Electrical Aerosol Detectors (EADs)
- Aerosol Electrometers

This manual covers the use of the Aerosol Instrument Manager software with TSI Scanning Mobility Particle Sizer™ (SMPS™) Spectrometers only. For information about software operation with other TSI spectrometers and sensors, refer to the appropriate manual.

This manual assumes you have Microsoft® Windows® 2000 or Windows® XP on your computer and that you are familiar with how Windows works. If you are not familiar with Windows, please refer to the information that came with it before you load and use this program.

°Microsoft and Windows are registered trademarks of Microsoft Corporation.
How This Manual is Organized

This manual describes the Aerosol Instrument Manager software and includes information such as:

- Requirements for loading and running the software.
- The installation procedure that loads the program onto your computer.
- A “Getting Started” chapter that introduces basic software operation.
- “How to...” information for using the program to operate and collect data with the SMPS spectrometer.
- Descriptions of the menus and menu items that are valid when collecting data with an SMPS spectrometer.
- Appendixes that provide reference information associated with program operation.

Notations/Conventions Used in This Manual

- Throughout this manual when reference is made to “Windows,” it implies either Windows® 2000 or Windows® XP operating system.
- Bold face type is used to indicate that you should perform the indicated action. For example “select the File menu” means that you should use the mouse and click on the menu called File.
- When instructions direct you to select items from a menu, a vertical bar (|) is used to separate the items you should select. For example, “select File | Properties | Scheduling” means you should click on the File menu, then select the Properties item, and then select the Scheduling tab.
- The term “active window” is used to refer to the window that is open on the desktop and is in focus. To verify which window is active, select the Window menu and note which item has a checkmark by it. You can make a window active by moving the pointer to that window and clicking the mouse button.
CHAPTER 2
Installing the Software

This chapter describes the installation requirements for the Aerosol Instrument Manager® software and the installation procedure.

*Note:* If the Data Merge software, is being used with the Aerosol Instrument Manager® software, it should be installed as listed:

C:\Program Files\tsi\Data Merge Software Module\DataMerge.exe

When installed correctly, Aerosol Instrument Manager activates the data merge software and the Data Merge icon appears (illé ) on the main toolbar. For more information on the Data Merge software, please refer to the Model 390069 Data Merge Software Module manual (P/N 1930074).

## Installation Requirements

To use this software we recommend a personal computer with the following minimum features, components, and software:

- A Pentium® 586 processor or higher.
- A SVGA color monitor.
- Microsoft Windows® 2000 or Windows® XP operating system.
- A hard drive large enough to accommodate Windows, the Aerosol Instrument Manager software, and data files.

*Note:* The amount of disk space required depends on the number of samples you collect, the amount of information collected, and the sampling period. After you have collected a number of samples, you may want to look at the file size to estimate how much storage space you will be using.

- A CD-ROM drive.
- 256 MB or more of random access memory (RAM).
- A mouse.

---

® Pentium is a registered trademark of Intel Corporation.
® Microsoft® Windows® are registered trademarks of Microsoft Corporation.
An RS-232 serial interface port or a USB port for each instrument connected (in addition to the one that may be required for the mouse). USB connections are available for Series 3770 CPCs and Series 3780 WCPCs.

*Note: Three Series 3770 CPCs can be connected using USB to collect data simultaneously.*

A Microsoft Windows-compatible printer is optional.

---

**Installation**

Install the Aerosol Instrument Manager software as follows:

1. Shut down (exit) all programs/applications on the Windows desktop.

2. With the computer on and Windows running, insert the Aerosol Instrument Manager CD-ROM in your CD drive to run the *autorun.exe* from the CD.
   
   a. If AutoPlay is enabled on your PC, the setup program will begin automatically and the introduction screen is displayed on the Windows desktop.
   
   b. If AutoPlay is not enabled, select Run from the Start menu and type: `D:\autorun` (where D is the letter corresponding to your CD drive) in the Open box and press OK.

3. Follow the instructions as the setup program runs. When setup is complete, you should read the readme.htm file. This file contains information that could not be included in this manual. If you decide not to read the file immediately, you can access the file later using a browser such as Windows Explorer.

4. When the installation program finishes, remove the CD-ROM and store the CD in a safe place for later use.

The setup program creates a directory (folder) called “Aerosol Instrument Manager” on your hard disk (assuming you accepted the default directory name). The directory contains the required program files and sample data files.

The setup program also creates a new item in the Start Menu called “TSI” and an icon for the Aerosol Instrument Manager.

*Note: Before creating a TSI menu item, the setup program checks for an existing one. If one is present, it adds the icon only.*
CHAPTER 3  
Getting Started

This chapter is designed to give you an introduction to the basic operation of the Aerosol Instrument Manager® software. Using it, you will:

- Start the program.
- Open an existing file (from the example files provided with the program).
- Change data display.
- Display another sample in the same file.
- Playback (review) data samples in a “slide show” fashion.
- Select a data hot spot.
- Delete/Undelete samples.
- Zoom in and zoom out on data in a graph.
- Print information displayed on the desktop.
- Export data to a file.
- Arrange open windows.
- Quit the program.

Start the Program

To start the program, proceed as follows:

From the Windows desktop, using the mouse, double-click the Aerosol Instrument Manager icon or press the Start menu and then select Programs|TSI|Aerosol Instrument Manager.

The Aerosol Instrument Manager desktop appears as shown in Figure 3-1.
Open an Existing File

1. Select **File|Open** or on the toolbar. The “Open Instrument Associated Data Files” window opens.

2. When the “Open Instrument Associated Data Files” window appears, select the correct extension for the file you want to open in the “Files of type” box. For example, for an SMPS spectrometer, the file extension is .s80.

If necessary, browse for the drive/directory where data files are stored. (Example files are included with the program and were installed in the Aerosol Instrument Manager folder when the program was installed.)
3. Select the data file that you want to open and click Open. At least two windows open on the desktop: a window containing a graph of the sample data, and the Samples List window (Figure 3-1).

**Note:** If the file has been opened before, it may display more than one graph and/or table. The program remembers the windows that were open on the desktop when you last closed the file and reopens them when you access the file again. If the file contains a sequence of samples, you will be asked if you want to open all the files or just the one you originally chose. See Appendix E for information about sequence files.

The Samples List window opens whenever you open a data file and remains open on the desktop as long as the data file is open. Closing the Samples List window closes the data file (and all its open windows).

---

**Change Data Display**

For most spectrometers, you can view data in tables or graphs and in several different formats (for example, SMPS data can be viewed by raw counts, concentration, and so on). The following procedure provides an example of how you can change data display.

1. Open one of the sample SMPS files as described in “Open an Existing File”.

   With the graph window active on the desktop and the mouse on the graph, right-click the mouse to display various viewing options. Refer to “Format Menu” in Chapter 4 for detailed explanations.

   Notice the change in how data is displayed. (A checkmark next to one of the menu items means that a window for that selection is already open on the desktop. If you select a menu item that is already checked, the window containing that graph or table is brought to the top of the desktop and becomes the active window.)

2. Experiment with other views by making other windows active and selecting other options from the View menu to see how your selections change the data display.
Display Another Sample in the Same File

1. To display another sample in an open file, select the icon (go forward one sample) from the toolbar. The data for the next sample of the currently active file replaces the data in all the open windows.

2. You can continue to step through the samples by selecting the icon until you reach the last sample.

   The sample currently displayed in the open window is highlighted in the Samples List window.

   Another method of changing the sample that is displayed in the open windows on the desktop is by selecting the icon for that sample from the active Samples List window.

You can use the following icons to display other samples:

- First Sample. Advance to the first sample.
- Previous Sample. Go back to the previous sample.
- Next Sample. Advance to the next sample.
- Last Sample. Advance to the last sample.

Playback (Review) Data Samples

You can display sample graphs and tables in a slide show format (to preview sample results or compare sample differences) as follows:

1. From the Samples List window, select the samples you want to play back using one of the following actions:

   Select Sample | Select All, to play back all samples.

   or

   Select individual samples using the mouse and the Ctrl key to highlight those samples you want to see. (You must select at least two samples.)

   or

   Select a group of samples by holding down the left mouse button and moving the mouse to "rubber band" (outline) the samples you want to select.
Note: The Playback menu items and toolbar icons are only enabled when the Samples view is the active view.

2. When you have selected the samples you want to view, select Playback | Play. The setup box shown in Figure 3-2 appears.

![Playback Setup Dialog Box](image)

Figure 3-2
Playback Setup Dialog Box

3. Select the sample viewing time and whether you want the samples displayed once or continuously. Playback begins immediately. For better viewing, it may be necessary to minimize the Samples List window.

4. You can pause the playback at any time by selecting Playback | Pause. Select Playback | Play to continue playback where you left off. You can stop playback at any time by selecting Playback | Stop. When you stop playback, you cannot restart it. Use Playback | Pause and Playback | Play if you want to stop and start playback.

You can also control playback by using icons on the toolbar. The icons perform the following operations:

- Stop: Stop playback.
- Pause: Pause playback on current sample.
- Start: Start playback or restart playback.
Select a Data Hot Spot

When a graph is open on the desktop, you can find the values of a data point as follows:

1. Position the pointer on the bar, line, or peak (depending on the type of graph that is active). The pointer becomes a pointing hand.

2. Press the left mouse button to display the values. Figure 3-3, shows how the data values would be displayed for an SMPS spectrometer (diameter and number concentration).

Figure 3-3
Use the Mouse to Directly View Data Values

Tip: After you have a data hot spot selected, use the arrow keys or the “>” and “<” keys to move the cursor right or left (from one value to the next), or grab the vertical bar and drag it to another location. Refer to Appendix B for a list of other keys or key combinations you can use to navigate and perform operations without using the mouse.

Delete/Undelete Samples

To delete samples from a file, you must first mark them for deletion and then either Close or Save the file. The following procedures will permanently delete samples from a file:

Mark samples for deletion as follows:

1. Select the sample you want to delete from the Samples List window (you can select multiple samples).
2. Select **Sample|Delete/Undelete Sample** or ![x] on the toolbar. The samples will be shown as “Deleted.” However, they will not be permanently removed from the file until you **Close** or **Save** the file.

Save the file and permanently delete all samples marked for deletion:

1. With at least one sample marked for deletion in the active file, select **File|Save**. You will get a message stating: “Some samples have been marked for deletion. Do you want them permanently removed?” Click **Yes** to remove them or **No** to keep them.

2. Select **Yes**. The samples marked for deletion are permanently deleted.

**Note:** If you attempt to close all the windows for the file or exit the program without saving the file, you will get a message asking whether you want to save changes to the file. Respond **Yes** and you will get the same message stating “Some samples have been marked for deletion. Do you want them permanently removed?” Respond **Yes** to delete the marked samples and **No** to close the file without deleting them.

---

### Zoom In and Out on Data in a Graph

You can zoom in on data displayed in a graph as follows:

1. Use the mouse to position the cursor (pointer) at one corner of the area you want enlarged.

2. Press down on the left mouse button and drag the mouse to the opposite corner of the data you want enlarged.

3. Release the left mouse button. The area you selected is enlarged.

4. You can continue to zoom further by repeating steps 1 through 3.

To Unzoom, select **Format|Undo Zoom** or ![undo] on the toolbar. The enlarged area is returned to normal view.
Print Information Displayed on the Desktop

You can print the information displayed in the active window on the desktop as follows (you must have a printer properly installed):

1. With a graph or table window active on the desktop, select **File|Print Preview** or 

2. Review that what you see in the print preview window is what you want to print (an example is shown in Figure 3-4), and then select **Print** from the Preview box. The contents of the window are sent to your printer.

You can immediately print a window without previewing it by selecting **File|Print** or 

![Figure 3-4 Print Preview](image)

Export Data to a File

You can export data from an SMPS Aerosol Instrument Manager file (either a single sample of the file or multiple samples of the file) for use in another program such as Microsoft Excel or Microsoft Access database. You can export data either manually or automatically. Refer to **Chapter 4** for information on exporting SMPS data to the database.
To Export Data to a File Manually

To export data to be used in another program:

1. Select the sample or samples to be exported as follows:

   To export data from a single sample, display the sample data in an active window on the desktop.

   To export data from multiple samples, select (highlight) the samples you want to export from the Samples List window.

2. Select File | Export to File. An Export Parameters dialog box appears as shown in Figure 3-5.

![Export Parameters Box](image)

Figure 3-5
The Export Parameters Box.

3. Select the type of data you want to export as well as the format you want to export the data in.

   Data can be exported in a delimited text file and you can select from three delimiters: tab, comma, or semicolon. The orientation of data can be either column or row.

4. Click OK.

5. Select the drive/directory you want to export the data to and enter a filename. The system automatically adds the .txt file extension.

6. Click Save.
Figure 3-6 illustrates how an exported *.txt file is formatted for an SMPS spectrometer.

To Export Data to a File Automatically

To export data automatically to a file for use in another program (such as Microsoft® Excel):

1. Establish a connection to the spectrometer by choosing File|New or File|Open.

2. If not already connected, select Run|Connect to the CPC.
   
   *Note: Perform the following step before you start collecting the data.*

3. Select Run|Auto Export to File. Select the type of data you want to export as well as the format you want to export the data in, using the Export Parameters dialog box (see Figure 3-5 on previous page).

4. Select Run|Start Data Collection. The data is exported to the file as it is collected.

Arrange Open Windows

When you have several windows open on the desktop it is helpful to arrange them for easier viewing.

® Microsoft and Excel are registered trademarks of Microsoft Corporation.
To arrange windows, select an item from the **Window** menu. You can arrange windows on your desktop horizontally, vertically, have them cascade, or arrange them in a predetermined auto-fit 2-pane or 4-pane layout. Refer to your Windows documentation for examples and more information for tile horizontal, tile vertical, and cascade layouts. Press the button (or **Ctrl+L**) in the toolbar for the four-pane layout or press the button (or **Ctrl+K**) for the two-pane layout as shown in Figure 3-7 for a spectrometer file.

All of the program windows that are currently open on the desktop are listed at the bottom of the **Window** menu under the **Close All** item. To make a window active and bring it to the top of all windows, select the name of the window from the list of open windows.

**Figure 3-7**

Two-Pane Layout of an SMPS File
Quit the Program

To end the program, select File|Exit. All windows and files open on the desktop are closed. If you have made changes to a file and have not yet saved it, you will be prompted to do so.
CHAPTER 4
SMPS™ Spectrometer
Procedures

Before using the information in this chapter, read Chapter 3. That chapter provides getting started information to help you understand the basics of how the program works. It also includes procedures common to all spectrometers.

The subsections of this chapter provide:

- “How To...” information for: collecting sample data with an SMPS spectrometer, setting up properties for an SMPS, appending sample data to an existing SMPS file, exporting SMPS data to a Microsoft Access database.
- A description of all menus and menu items available when using the SMPS spectrometer or viewing SMPS data files.

How To Collect Sample Data

There are three steps for collecting sample data.

- Step A: Open a new SMPS file
- Step B: Review/change parameters
- Step C: Start data collection

Note: You can append SMPS sample data to an existing file. Refer to “Append Sample Data to an Existing SMPS File” below.

Before you begin, make certain you have connected the CPC to the computer and the spectrometer is running. Refer to the appropriate hardware instruction manual if necessary.

Step A: Open a New SMPS File

To open a new SMPS File:

1. Select File|New or [New] on the toolbar. The New Instrument and Associated Data File dialog box (Figure 4-1) opens on your desktop.
Figure 4-1
Select an SMPS Filename When You Open a New File

Note: The following step must be performed before you start collecting data.

2. Select a filename (and, optionally, a location other than the Aerosol Instrument Manager folder). The default name is “AIM1” for the first file you open, “AIM2” for the second file you open and so on.

   You can accept the default name or enter any name you choose.

3. Verify that the “Files of Type” box indicates the correct extension for the spectrometer you are using (.S80 for an SMPS spectrometer). You do not need to enter an extension in the filename box. It is assigned automatically.

4. Click the Open button.

If you open a new file and the SMPS Properties dialog is not complete (this can occur the first time you open a new file for the SMPS spectrometer or after you have selected File|Clear Settings) the SMPS Properties dialog box appears and you must complete it and press OK to proceed.

If you get the following error message when opening a New file, press the OK button to open the Properties dialog box.
Verify the connection to the spectrometer and make certain the spectrometer is turned on. To verify the Com or USB Port setting:

a. Check that the correct communications port was selected during program setup by double-clicking on the port listed under the Communications Tab.

b. If the test is unsuccessful, select another port and double click on the port again.

*Note:* The new Series 3770 CPCs have USB ports to connect to the computer. The Series 3780 Water-based CPCs also have USB ports but they are treated as serial ports using a USB driver. See instrument manual for details.

c. Once the correct port is selected, select **OK** to return to the desktop and the active window.

### Step B: Review/Change/Set Up SMPS Properties

Before you begin sampling, you may want to review the Properties dialog to verify correct start time, hardware settings, and so on.

Select **File|Properties** or **Run|Properties** (or **Ctrl+R**) and select the various tabs to review the settings. Refer to “Setting Up Properties for an SMPS Spectrometer” for how to change settings.

Once you have set up the parameters or verified they are correct, close the Properties dialog box and continue with Step C.

### Step C: Start Data Collection

After you have completed the properties dialog, data collection begins at the “Start At Time” you set on the Properties dialog or immediately after you do one of the following:

- Select **Run|Start Data Collection** using the menus.
- Click on the toolbar.
- Double-click the New Sample icon in the Samples List window.
When the program begins collecting sample data, the data is displayed in the windows that are open on the desktop.

As each sample finishes, the data for the sample is stored and a new sample begins. When the last sample finishes, sampling stops, but the windows remain open.

To stop data collection before all the samples are collected, do one of the following:

- Select Run|Finish Current Sample. Data collection stops after the current sample finishes.
- Select Run|Abort Current Sample or on the toolbar to stop data collection immediately. When you select Abort Current Sample, the data collected for the current incomplete sample is discarded.

### Setting Up Properties for an SMPS Spectrometer

To access the Properties dialog box for an SMPS spectrometer, select File|Properties or Run|Properties (or Ctrl+R) when an SMPS file is active on the desktop.

The properties displayed in the Properties dialog box are either:

- The initial default properties as set by TSI or
- The default properties set by a user who selected File|Save Properties as Default after making changes to the Properties dialog box or changed the settings and had the File|Save Properties on Exit menu item checked.

The Properties dialog box contains four tabs: Hardware Settings, Scheduling, Physical Properties, and Communications. Each is described below.

If this is the first time you have accessed the Properties dialog, you will need to set up the parameters before continuing. If you have set up the properties before, verify they are correct and press OK. The following paragraphs describe the settings for each tab of the Properties dialog box.

**Note:** If you want to use the same settings the next time you open a new file, remember to either select File|Save Settings As Default or have the File|Save Settings on Exit menu item checked after you have completed the Properties dialog. Once
your settings have been saved, the properties dialog will not open automatically when you open a new file.

Some properties of an existing sample can be changed through the Properties dialog. If a common property of multiple samples needs to be changed, you can first select the samples and then access the Properties dialog to change the property of all the selected samples.

SMPS Hardware Settings Tab

Use the Hardware Settings tab to specify hardware settings for the SMPS spectrometer. The fields on the tab vary depending on the model of classifier and the DMA model of your SMPS spectrometer. Figure 4-2 illustrates the tab for the Model 3080 Classifier with a 3085 Nano DMA. Table 4-1 describes each of the fields/settings.

You cannot close the Properties dialog or select any of the other tabs until all values have been set on the Hardware Setting tab.

Figure 4-2
Hardware Settings Tab of the Properties Dialog for Model 3080 Classifier with a 3085 Nano DMA
### Table 4-1

**Descriptions for SMPS Hardware Settings Tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classifier Model</td>
<td>Select the model of Electrostatic Classifier used in the system.</td>
</tr>
<tr>
<td>DMA Model</td>
<td>Select the model of Differential Mobility Analyzer used in the system.</td>
</tr>
<tr>
<td>HV Polarity</td>
<td>This is the polarity of the high voltage controller which is installed on your 3080 classifier. A <strong>negative high voltage controller is the default configuration</strong> and is used to measure positively-charged particles with your SMPS spectrometer. Your selection must match the polarity of the high voltage controller physically installed in your 3080. According to your selection, the Aerosol Instrument Manager software will read the appropriate charge correction file (ChargeAim.dat for negative high voltage controller or ChargePos.dat for positive high voltage controller) and apply this to your data. <strong>Note: Do not change this setting without physically changing the high voltage controller installed in your 3080! Refer to the 3080 manual on how to order a positive high voltage controller and how to install it.</strong></td>
</tr>
<tr>
<td>Impactor Type</td>
<td>Select the type of impactor used in the system.</td>
</tr>
<tr>
<td>CPC Model and Flow Rate</td>
<td>Select the Condensation Particle Counter used in the system and the high or low flow rate for the Model 3022A, 3025A, 3775, and 3776 CPCs. Each model of CPC differs in concentration range, sample flow rate, and other specifications. To avoid large errors in measured particle distributions, make sure the CPC selected matches the one in your SMPS system.</td>
</tr>
<tr>
<td>Inlet Flow Rate (L/min)</td>
<td>This option only appears when a Model 3022A CPC with a high flow rate is selected. Enter the inlet flow rate of the CPC. The value must be in the range 1 to 2.</td>
</tr>
<tr>
<td>Aerosol Flow Rate (L/min)</td>
<td>Enter the aerosol flow rate for the DMA. The value should be in the range .2 to 2.0.</td>
</tr>
<tr>
<td>Sheath Flow Rate (L/min)</td>
<td>Enter the sheath flow rate for the DMA. The value should be in the range 2 to 20.</td>
</tr>
<tr>
<td>td (s)</td>
<td>td is the time for the aerosol to flow through the sample column of the classifier and the connection tubing between the DMA and the CPC which is assumed to be 10 inches long. Although you can enter a value for td (0 to 10 seconds), it is recommended that you use the value calculated from the hardware settings.</td>
</tr>
<tr>
<td>tf (s)</td>
<td>The tab shows the tf (in seconds) of your SMPS spectrometer. tf is the calculated time for the aerosol to flow through the sample column of the classifier. The calculation of tf is based on the classifier’s sheath air flow rate, the polydisperse aerosol flow rate, and the geometry of the classifier.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>D50 (nm)</td>
<td>The tab shows the $D_{50}$ cut point for the impactor at the inlet of your SMPS spectrometer. The $D_{50}$ cut point is the 50% cut-point diameter of the impactor. It changes if you change the size of the impactor or the polydisperse aerosol flow rate.</td>
</tr>
<tr>
<td>Size Range Bound (Diameter)</td>
<td>Enter the minimum and maximum size range to be sampled using the pull-down lists. The minimum and maximum size limits are determined by the DMA flow rates of your system. You can select the particle diameter range to view with this option, but choose new flow rates will change the available particle diameter sampling range.</td>
</tr>
<tr>
<td>Set to Max Range</td>
<td>Select this button to automatically set the Size Range Bounds to the maximum range based on the current DMA and flow settings. Calculation is based on Max and Min voltages ($v_{min} = 10$ and $v_{max} = 10,000$ for the 3080 classifier; $v_{min} = 10$ and $v_{max} = 11,000$ for the 3071 classifier).</td>
</tr>
<tr>
<td>Voltage Range</td>
<td>Displays the voltage range based on the size range selection.</td>
</tr>
<tr>
<td>Scan Time</td>
<td>Enter the Scan Up and Scan Retrace times (in seconds). Scan Up time is the period during which the classifier center rod voltage is exponentially increasing in magnitude. Size distribution data is sampled during Scan Up. The Scan Up range is 20 to 300. At the start of the Scan Retrace time period, the classifier voltage is reset to its initial voltage. The Scan Retrace range is 10 to 300. Scan time selection depends on several factors including: desired particle size accuracy, CPC response time, flow rates, and particle size range. Generally, longer scan times provide better data, while decreasing the scan time results in a decrease of the particle size accuracy of the SMPS system. Accuracy decreases for three reasons: (1) smearing effects caused by the response time of the CPC, (2) the increased dependence on the exact value of $t_d$, and (3) the increase in granularity of the data. Typically, a 120-second Up Scan and a 15-second Retrace Scan (default values) provide adequate accuracy and are a good starting point. Use a shorter scan time (30 seconds) for measurements in which the aerosol changes substantially during the sample period. Use a longer scan time for measurements in which there is a low concentration and a high particle size accuracy is desired.</td>
</tr>
<tr>
<td>Down Scan First</td>
<td>Select this box to perform a down (retrace) scan first. The box is available only for the Classifier Model 3071.</td>
</tr>
</tbody>
</table>

SMPS™ Spectrometer Procedures
SMPS Scheduling Tab

Use the Scheduling tab to select:

- The number of scans per sample
- The number of samples to be taken
- How often samples are collected
- The start time for the first sample

Figure 4-3 shows the Scheduling tab of the Properties dialog. Table 4-2 provides a description of each parameter.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Up</td>
<td>Displays the value selected in the Hardware Settings tab.</td>
</tr>
<tr>
<td>Retrace</td>
<td>Displays the value selected in the Hardware Settings tab.</td>
</tr>
<tr>
<td>Scans per Sample</td>
<td>Enter the number of scans you want to take per sample.</td>
</tr>
<tr>
<td>Number of Samples</td>
<td>This is the total number of samples you want to collect. The maximum value allowed is 65535.</td>
</tr>
<tr>
<td>Total Sample Time</td>
<td>This field is calculated by the software and shows the total sample time based on the values you entered in the previous boxes. The value is displayed in hours, minutes, and seconds.</td>
</tr>
<tr>
<td>Scheduled</td>
<td>Select Only Once to collect one set of samples. For continuous monitoring, select Repeat Every and then select the hours and minutes between samples. The intersample time should be longer than the Total Sample Time to include the overhead time that is needed for file handling.</td>
</tr>
<tr>
<td>Start At Time</td>
<td>If you don't check this box, sampling begins as soon as you select Start Data Collection. If you want to select a start time, check the box and enter the clock time at which you want sampling to begin. The program uses a 12-hour or 24-hour clock, depending on how your PC is set up. If your PC is set up to use a 12-hour clock, you must indicate if the time is am or pm by unchecking the PM box or checking the PM box. The reference time for the program is the time at which your computer is set.</td>
</tr>
<tr>
<td>Trigger File</td>
<td>Specify a file name only (not a complete pathname) of a text file. This file when updated in the same directory where Aerosol Instrument Manager is installed, will act as a trigger to start SMPS sampling. For example, specify “trigger.txt” in the edit box. When you wish to trigger the sampling to begin, create or update the file trigger.txt in the Aerosol Instrument Manager directory (Note: the contents of this file are not read).</td>
</tr>
</tbody>
</table>

**Files of Sample Sessions That Run Past Midnight**

The files for sample sessions that run past midnight are handled differently than those that start and stop on the same date. In this case a sequence of files is created, with each file in the sequence given a unique filename identifying its proper order. Appendix E provides a complete description of sequence files including how to access a file that is part of a sequence.
SMPS Physical Properties Tab

Use the Physical Properties tab (Figure 4-4) to specify the physical properties of the sample, provide a title for the sample and enter any comments about the sample that you want to keep with the file.

Table 4-3 describes the fields of the Physical Properties tab.

![Figure 4-4](image)

Physical Properties Tab of the SMPS Properties Dialog

Table 4-3

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gas Viscosity</td>
<td>Enter the gas viscosity of the gas carrying the aerosol. The range is less than 1.0 and greater than 0.0. If you are using air, press the <strong>Set to Defaults for Air</strong> button.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution:</strong> Extreme values will cause incorrect results.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Mean Free Path</td>
<td>Enter the calculated mean free path between particles. The range is less than 1.0 and greater than 0.0. If you are using air, pressing the <strong>Set to Defaults for Air</strong> button automatically enters the appropriate value for you.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution:</strong> Extreme values will cause incorrect results.</td>
</tr>
<tr>
<td>Set to Defaults for Air</td>
<td>Press this button to enter default values for the Gas Viscosity and Mean Free Path fields.</td>
</tr>
<tr>
<td>Particle Density</td>
<td>Enter the particle density (in g/cc) of the aerosol. This value is used in the calculation of mass distributions. Default = 1.2 g/cc.</td>
</tr>
<tr>
<td>Multiple Charge Correction</td>
<td>If this box is selected (a checkmark indicates it is selected), it enables a mathematical correction for particles with multiple charges, see below.</td>
</tr>
<tr>
<td>Diffusion Correction</td>
<td>If this box is selected (a checkmark indicates it is selected), it enables a mathematical correction for diffusion losses. Enter the carrier gas density. This will be used in the calculation of the Diffusion Correction.</td>
</tr>
<tr>
<td></td>
<td>See below and <strong>Appendix G</strong> for more information.</td>
</tr>
<tr>
<td>Nanoparticle Aggregate</td>
<td>If this box is selected (a checkmark indicates it is selected), it enables a mathematical analysis of mobility data for nanoparticle aggregates.</td>
</tr>
<tr>
<td>Mobility Analysis</td>
<td>Enter the Primary Particle Diameter and the Orientation. This information will be used in the calculations.</td>
</tr>
<tr>
<td></td>
<td>See below and <strong>Appendix H</strong> for more information.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The upgrade version of the SMPS Software (AIM3936-UD) does <strong>not</strong> support this feature.</td>
</tr>
<tr>
<td>Title</td>
<td>Enter a title to identify the sample.</td>
</tr>
<tr>
<td>Instrument ID</td>
<td>The instrument ID is a string used to identify the hardware from which the sample was collected.</td>
</tr>
<tr>
<td>Comment</td>
<td>Enter any comments you want to keep with the sample.</td>
</tr>
</tbody>
</table>

**Multiple Charge Correction Option**

Choose the Multiple Charge Correction check box on the Physical Properties tab to enable a mathematical correction for particles with multiple charges. Display options, with the exception of Count, automatically account for single-charge probability.

Multiple charges on a particle increase its mobility. Since the program assumes a particle has only one charge, the effect of multiple charges on a particle allows the particle to be incorrectly binned into a smaller-sized particle channel. Multiple Charge
Correction, if activated, turns on an internal algorithm that attempts to correct the sample data for the effects of the multiple charged particles. The algorithm performs corrections based on a 64-channel resolution. The program assumes the impactor removes any particles larger than its cut-point size ($D_{50}$). Therefore, the particles in the size channel immediately smaller than the impactor cut-point size must be made up of single-charged particles, because particles with multiple charges are larger in size than the $D_{50}$ cut point.

The concentration in each size bin is calculated. Once the concentration for a bin is determined, the program subtracts the number of multiple-charged particles that it would have been expected to fall in smaller-sized bins. The SMPS program then moves to progressively smaller size channels and continues to subtract the effect of multiple-charged particles.

The effects of multiple-charged particles are most pronounced for particles above approximately 100 nm. The efficiency of multiple charge correction is dependent on several factors and assumptions. Ideally, the $D_{50}$ for the impactor should be precisely at the upper valid measurement range.

The impactor removes particles based on their aerodynamic size. The program sizes particles based on their electrical mobility, which closely matches particles' geometric diameter. For particle densities other than 1.0, the impactor geometric cut point occurs at a point other than that predicted by the SMPS program. If the number of particles near the $D_{50}$ of the impactor is low, precise cutoff is less critical. Particles with a size larger than the maximum size set for the SMPS measurement and not removed by the impactor will cause errors in the correction for multiple charges. Low concentrations increase the uncertainty of the particle concentration in any channel, thus reducing the effectiveness of the correction.

View data in both corrected and uncorrected forms to become familiar with the effect of multiple charges and the limitations of charge correction.

**Diffusion Correction Option**

Choose the Diffusion Correction check box on the Physical Properties tab to enable a mathematical correction for diffusion losses of particles in their flow path within the SMPS system. It is especially important to use diffusion loss correction when sizing aerosols smaller than 100 nm, since in this size regime diffusion becomes increasingly important. Enter the carrier gas density in
units of g/cc. This value will be used in calculations of the diffusion correction.

The diffusion correction can be applied to previously collected data similar to charge correction. For a detailed discussion on this subject, please refer to our application note on Diffusion Loss Correction (Appendix G of this manual).

Nanoparticle Aggregate Mobility Analysis Option

Choose the Nanoparticle Aggregate Mobility Analysis check box on the Physical Properties tab to enable a mathematical analysis of mobility data for nanoparticle aggregates. By default, the software analyses the mobility raw data for a spherical particle model. However, not all particles are necessarily spherical. For example, urban ultrafine particles and particle emissions from combustion sources such as diesel engines are typically aggregates. The nanoparticle mobility analysis yields a more accurate estimate of the number, surface area and volume distributions of nanoparticle aggregates.

Enter the primary particle diameter, i.e., diameter of the primary particles that constitutes the aggregate. The assumption here is that aggregates are composed of primary particles all of which have the same (known) diameter. Enter the orientation of aggregate (parallel or random with respect to the electric field). Default is parallel orientation. Electrical conducting aggregates like diesel exhaust and most ambient ultrafine particles align parallel to the electric field due to interaction of induced fields.

The nanoparticle mobility analysis can be applied to previously collected data similar to charge correction and diffusion correction. For a detailed discussion on this subject, please refer to our application note on Nanoparticle Aggregate Mobility Analysis (Appendix H of this manual).

SMPS Communications Tab

The Communications tab, Figure 4-5, lets you set up and test the communications port. It is only available when you open a new file or when you select Run | Connect to the CPC on an open file. Table 4-4 describes the fields and parameters of the Communications tab.
Append Sample Data to an Existing SMPS File

To append sample data to an existing SMPS file:

1. Open the file that you want to append data to.
2. Select Run | Connect to the CPC.
If a connection is not found, the Properties dialog opens. Select the Communications tab to establish a connection with the SMPS spectrometer’s CPC.

Once there is a valid CPC connection, the New Sample icon appears in the Samples List window and the Start Data Collection button is enabled on the toolbar. You can then append samples to the data file (see Step C—Start Data Collection, above).

**Export SMPS Data to an Access Database**

An Access database named “Aerosol Instrument Manager.mdb” is installed during installation in the program directory. Before you can export SMPS data to this database, however, you must first set up the database for use.

**Note:** Microsoft Access is part of the Microsoft Office software (beginning with Office 97). To use the database, you must install Microsoft Access on your computer. Refer to the documentation that came with the program for the procedure.

**To Set Up the Database**

1. From the Windows Start menu, select Settings.
2. From Settings, select Control Panel.
3. Select the Data Sources (ODBC) icon under Administrative Tools and double-click on it.
4. On the User DSN tab, select MS Access Database and then select Add.
5. Select Microsoft Access Driver (*.mdb) from the Create New Data Source dialog, and then press the Finish button.
6. Type “Aim” in the Data Source Name field on the ODBC Microsoft Access Setup dialog then press the Select button.
7. Navigate to the “Aerosol Instrument Manager.mdb” file (in your installation directory) and press OK.
8. Press OK on the ODBC Microsoft Access Setup dialog. The database is now ready for use. See below for a description of the tables in the database.
To Export Data to the Database

1. Select File | Connect to Database.

   **Note:** Only one file can be connected to the database. If you want to export data to the database from another file, you must disconnect the first file using File | Disconnect Database. Then you can connect the second file to the database.

2. There are two ways to export data.

   The preferred way to export data is to export it while collecting it. To do so, select Run | Auto Export to Database before you collect data. Data is exported as it is collected. Do not continue with step 3.

   If you have already collected the data and want to export it to the database, you must continue with step 3. Exporting data from existing files consumes a lot of computer resources, and is a slow process.

3. Select the sample or samples to be exported as follows:

   To export data from a single sample, display the sample data in the active graph or table window on the desktop.

   To export data from multiple samples, select (highlight) the samples you want to export from the Samples List window.

4. Select File | Export to Database. The data is exported to the database.

   **Note:** Be aware that exporting a group of samples to the database takes considerable time. Do not exit the program or close the file while it is writing to the database.
Database Tables

The following information is collected in tables of the Access database.

<table>
<thead>
<tr>
<th>T-00 Header</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>test num</td>
<td>The test number. This number links the data in the different tables. For auto export, it is incremented for each “start data collection.” When manually exporting data, each sample has a different test number.</td>
</tr>
<tr>
<td>title</td>
<td>As specified in the Properties dialog.</td>
</tr>
<tr>
<td>comment</td>
<td>As specified in the Properties dialog.</td>
</tr>
<tr>
<td>test date</td>
<td>Date of the FIRST sample for this test number.</td>
</tr>
<tr>
<td>filename</td>
<td>Filename of the data file.</td>
</tr>
<tr>
<td>instrument id</td>
<td>Identifies the hardware the sample was collected from. It is read from the instrument, or as specified in the Properties dialog.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T-00 10 SMPS Settings</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>test num</td>
<td>The test number.</td>
</tr>
<tr>
<td>classifier model</td>
<td>As specified in the Properties dialog.</td>
</tr>
<tr>
<td>DMA model</td>
<td>As specified in the Properties dialog.</td>
</tr>
<tr>
<td>DMA inner radius</td>
<td>As specified in the Properties dialog.</td>
</tr>
<tr>
<td>DMA outer radius</td>
<td>As specified in the Properties dialog.</td>
</tr>
<tr>
<td>DMA characteristic length</td>
<td>As specified in the Properties dialog.</td>
</tr>
<tr>
<td>CPC model</td>
<td>As specified in the Properties dialog.</td>
</tr>
<tr>
<td>gas temperature</td>
<td>Constant, set in software.</td>
</tr>
<tr>
<td>gas pressure</td>
<td>Constant, set in software.</td>
</tr>
<tr>
<td>gas viscosity</td>
<td>As set in the Properties dialog.</td>
</tr>
<tr>
<td>mean free path</td>
<td>As set in the Properties dialog.</td>
</tr>
<tr>
<td>channels per decade</td>
<td>As set in the Format menu.</td>
</tr>
<tr>
<td>multiple charge correction</td>
<td>As set in the Properties dialog.</td>
</tr>
<tr>
<td>impactor type</td>
<td>As set in the Properties dialog.</td>
</tr>
<tr>
<td>up scan</td>
<td>As set in the Properties dialog.</td>
</tr>
<tr>
<td>retrace</td>
<td>As set in the Properties dialog.</td>
</tr>
<tr>
<td>down scan first</td>
<td>As set in the Properties dialog.</td>
</tr>
<tr>
<td>scans per sample</td>
<td>As set in the Properties dialog.</td>
</tr>
<tr>
<td>sheath flow</td>
<td>As set in the Properties dialog.</td>
</tr>
<tr>
<td>aerosol flow</td>
<td>As set in the Properties dialog.</td>
</tr>
<tr>
<td>CPC inlet flow</td>
<td>As set in the Properties dialog.</td>
</tr>
<tr>
<td>CPC sample flow</td>
<td>As set in the Properties dialog.</td>
</tr>
</tbody>
</table>
**Active Menus for an SMPS Spectrometer**

This section describes the various functions available for an SMPS through the menus on the Aerosol Instrument Manager desktop. The Menus include: File, Run, Playback, Format, View, Sample, Window, and Help.

Which menus are available depends on the operation you are currently performing on the desktop.

In addition to the menus, a toolbar (located just beneath the desktop menus) is available to provide shortcuts to many of the functions in the menus. You can hide the toolbar if you want to enlarge the desktop, see the description of the View Menu, below.

**Note:** All menus and menu items are described below. Depending on the operation you are currently performing and the window
that is active on the desktop, the menu may appear different than shown, i.e., some menu items may not be available.

File Menu

The items of the File menu are used to open, save, and recall files and perform other program operations.

<table>
<thead>
<tr>
<th>File</th>
<th>Run</th>
<th>Playback</th>
<th>Format</th>
<th>View</th>
<th>Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ctrl+N</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open...</td>
<td>Ctrl+O</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save As...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Import</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Export To File...</td>
<td></td>
</tr>
<tr>
<td>Export To Database...</td>
<td></td>
</tr>
<tr>
<td>Connect to Database</td>
<td></td>
</tr>
<tr>
<td>Disconnect Database</td>
<td></td>
</tr>
</tbody>
</table>

| Properties... | Ctrl+R |
| Save Properties On Exit |   |
| Save Properties As Default |   |
| Clear Settings |       |

| Print... | Ctrl+P |
| Print Preview |   |
| Print Setup... |       |

1. Outdoor Air, S80
2. Sodium Chloride, low flow, S80
3. AAAR2005Thursday, S80
4. CMAG, A21

Exit

Figure 4-6
File Menu for an SMPS Spectrometer

New

Select **File | New** or on the toolbar to open a new file and prepare to collect sample data.

After you select **New**, you are prompted to enter a filename. Accept the default filename or enter any filename you chose then select **OK**.
A Samples List window and a graph window open on the desktop with the filename you entered and you are ready to start collecting data. Refer to "How to Collect Sample Data" for a complete description.

**Note:** If this is the first time you have selected New, you may be required to fill in the Properties dialog before continuing.

### Open

Select **File|Open** or  on the toolbar to open an existing file. By default, sample files are stored in the same directory as the Aerosol Instrument Manager program. All files will automatically be given the appropriate filename extension according to the spectrometer model you are using (see above description). If you store data files in another directory or on another drive, you must first display the file pathname in the Open window before you can select and open it.

**Note:** When opening files for sample sessions that run past midnight, refer to the description of Sequence Files in Appendix E and for information on how the files are opened.

When the file opens, a window opens on the Aerosol Instrument Manager desktop containing data from the first sample in the file.

You can have many samples and many files open on the desktop at the same time. Only one window, however, is the active window.

### Close

Select **File|Close** or  to close a file (and all the windows associated with it). If there are windows open on the desktop from more than one file, Close will close only those windows associated with the file whose window is currently active. If you attempt to close a file that has been changed but not saved, you will be prompted to save the changes before closing the file.

If you have marked a sample or samples for deletion, but have not saved the file, you will get the following message: “Some samples have been marked for deletion. Do you want them permanently removed?” If you click **Yes**, the sample files marked for deletion are permanently deleted. If you click **No**, the samples marked for deletion are not deleted. They are saved, and are no longer marked for deletion.

### Save

Select **File|Save** or  on the toolbar to save sample data to a file.
If you have marked a sample or samples for deletion, but have not saved the file, you will get the following message: “Some samples have been marked for deletion. Do you want them permanently removed?” If you click Yes, the sample files marked for deletion are permanently deleted. If you click No, the samples marked for deletion are not deleted. They are saved, and are no longer marked for deletion.

Save As
Select File | Save As to save data in an existing file to a new filename. (The file contents are duplicated to the new filename. If you want to delete the original filename, use Windows Explorer to do so.)

After you select Save As, you can select a drive/directory. You can use the same filename if you save the file to another drive/directory, but if you want to save the file to the same directory, you must give it a new name.

Do not add the filename extension. It is added automatically when you select Save.

Import
Select File | Import to import data into the program from previous versions of the software. For example, to import a file from the SMPS spectrometer, version 3.x or earlier, navigate to the directory that contains the SMPS file and select the file you want to import.

Export to File
Select File | Export to File to export data (either a single sample or multiple samples of a file) for use in another program. Data is exported in a delimited text file. Refer to “Export Data to a File” in Chapter 3 for information.

Export to Database
Select File | Export to Database to automatically export data to a Microsoft Access database. Refer to information provided earlier in this chapter.

Connect to Database
Select File | Connect to Database to connect the currently active file to the database. Only one file at a time can be connected to the database.
Disconnect Database

Select **File | Disconnect Database** to disconnect the file from the database. You cannot disconnect from the database while data is being written to the database. You are automatically disconnected from the database when you close the file that is connected to the database.

Properties...

Select **File | Properties** to set the parameters used by the Aerosol Instrument Manager software to collect sample data. The Properties dialog box has four tabs. The parameters that can be set for each spectrometer on each tab are described in “How to Collect Sample Data” earlier in this chapter.

Save Properties On Exit

Select **File | Save Properties On Exit** to save the settings in the Properties dialog to the aim.ini file when you close a file. By default, this setting is off. When it is selected (on), it is marked with a checkmark and indicates that each time you close a file, that file’s properties are stored in the aim.ini file and are used as the properties for the next New file.

Save Properties As Default

Select **File | Save Properties as Default** if you want the properties currently displayed in the tabs of the Properties dialog to be the default properties next time you open a New file.

Clear Settings

Select **File | Clear Settings** if you want to clear the Hardware settings in the Properties dialog. If you clear the hardware settings, you must fill in new hardware settings before you can begin collecting data again. (Each time you select **File | New**, the properties dialog box appears.) The settings are cleared from the aim.ini file.

Print

Select **File | Print** to print the active window on the desktop in a report format. If you want to preview the output before printing it, select **File | Print Preview** or .

Refer to your Windows documentation for information about the Print dialog box.
Print Preview

To avoid printing something you don’t want, select **File|Print Preview** to see what your printed output will look like before selecting **Print**.

Print Setup

Select **File|Print Setup** to set up the printer for printing. Refer to your Windows documentation and your printer’s documentation for information about setting the printer parameters.

List of Recently Accessed Files

Between the Printer Setup and Exit menu items is a list of the most recently accessed data files (a maximum of four files is displayed). These are accessed from the menu by selecting **File|1, 2, 3, or 4**.

The list provides a shortcut to these files so you can bypass the Open command. To open one of the files listed, use the mouse to highlight it and then click the left mouse button. The file opens on the desktop.

Exit

Select **File|Exit** to end the program.

Run Menu

The items available under the Run menu are used to start and stop data collection.

---

### Figure 4-7
Run Menu for an SMPS Spectrometer
Start Data Collection

With a new file open on the desktop, select Run | Start Data Collection or on the toolbar to begin collecting sample data. Samples are collected according to the sample length, number of samples, scheduled times and other parameters set in the tabs of the Properties dialog (see earlier in this chapter).

Note: If a start time is set, this menu item (and its associated icon) is disabled.

Once you select Start Data Collection, sampling begins immediately. As data is collected, it is displayed in the open windows.

Finish Current Sample

Select Run | Finish Current Sample when you want to stop collecting sample data prematurely (before the sampling period ends as set in the Properties dialog). When you select this item, the current sample is allowed to finish before sampling ends.

Abort Current Sample

Select Run | Abort Current Sample or from the toolbar when you want to stop collecting sample data immediately. When you select this item, sampling stops and the data for the current sample is discarded.

Connect to the CPC

Select Run | Connect to the CPC if you want to connect an open data file to append more samples to the file. If a connection is not found, the Properties dialog opens with the Communications tab selected to let you establish a connection with the CPC.

Once there is a valid CPC connection, the New Sample icon appears in the Samples List window and the Start Data Collection button is enabled on the toolbar. You can then append samples to the data file.

Disconnect from the CPC

Select Run | Disconnect from the CPC to disconnect an open file from the CPC and stop collecting samples. You cannot append samples to a file unless it is connected to the CPC. Once the CPC is disconnected, the New Sample icon is removed from the Samples List window and the Start Data Collection button is disabled.
Auto Export to File

Select **Run | Auto Export to File** to automatically export the data as it is collected to a file. When you select this menu item, an Export Dialog box opens. Select the type of data you want to automatically export, then press **OK**.

*Note*: You cannot auto-export raw data or export data in columns.

See “Export Data to a File.”

Auto Export to Database

Select **Run | Auto Export to Database** to automatically export the data as it is collected to the Access database. See “To Export Data to the Database,” earlier in this chapter for a description of how to export SMPS data to the database.

Properties…

This menu item provides a shortcut to the same Properties menu item listed under the File menu and appears here for convenience.

Select **Run | Properties** to display the Properties dialog that lets you set the parameters used by the Aerosol Instrument Manager software to collect sample data.

The parameters that can be set are described earlier in this chapter.

Playback Menu

The Playback menu appears only when a Sample List window is active on the desktop. Its purpose is to allow you to display graphic and table windows in series, like a slide show, so that you can compare samples or view a series of samples.

![Playback Menu](image)

Refer to “Playback (Review) Data Samples” in Chapter 3 for instructions.
Play

Select **Playback | Play** or 🎧 from the toolbar to display the control window for playing the samples you selected. First select the time you want each sample displayed (full speed, 0.5, 1.0, 2.5 or 5.0 seconds). Then select whether to view the samples once or continuously. As soon as you select **Play Once** or **Play Continuously**, the open views for the first sample you selected are displayed for the specified period, then the views for the second sample are displayed, and so on until all the samples selected have been displayed. If you selected **Play Continuous** from the Playback Setup dialog box, the series repeats itself indefinitely.

Pause

Select **Playback | Pause** or 🔄 from the toolbar to interrupt the playback of the samples. This feature lets you stop playback to view the data of an interesting sample without canceling the playback of all selected samples. When you want to start playback again, select **Playback | Play**.

Stop

Select **Playback | Stop** or 🚫 from the toolbar to end sample playback before all samples have been displayed. If you select **Stop** and you want to restart sampling, you must select **Playback | Play**, select the time you want each sample displayed, select play once or continuously, and begin displaying samples from the first selected sample.

Format Menu

The Format menu has many variations depending on the active window. The menu items of the Format menu let you control how information is presented in tables and graphs including: channel resolution, view boundaries, graph type, grid lines, font, color, etc.

When a Sample List window is active on the desktop, the menu items of the Format menu let you determine how items in the Sample List window are displayed. You can select large or small icons, or list the samples with or without details. Details include: date, pathname, and title of the sample.

When a window is active on the desktop, you can display the Format menu items (plus other menu items) by placing the cursor in the window and clicking the right mouse button.
Figure 4-9
Format Menu for an SMPS File (A) When a Graph Window is Active (B) When a Samples List Window is Active

**Y Axis**

This menu item is available only when a graph window is active on the desktop.

Select **Format | Y Axis** to select the way the Y axis is displayed, see Figure 4-10. By default, the graphs display in normal/auto scale. You can select Auto or Fixed scale and either log or normal scale. To display in logarithmic scale, check the **Log Scale** box.

If you select **Fixed Scale**, you must enter a minimum and/or maximum number (you do not need to enter both).

Figure 4-10
The Y-Axis Dialog Box

**Channel Resolution**

Select **Format | Channel Resolution** to select the displayed resolution of the measurement. The values 4, 8, 16, 32 and 64 channels/decade describe the resolution in terms of the number of particle size channels of uniform geometric width per decade of
particle size. A large number of particle counts during a sample allows the use of high-resolution display (i.e., 64/decade). Low count statistics make high resolution displays “noisy.” Lower resolution displays average adjacent channels, reducing the statistical variation. The actual resolution of the SMPS spectrometer is ultimately limited by the DMA, the sheath to aerosol flow ratio, and particle diffusion.

**View Boundaries**

Select **Format | View Boundaries** to display the View Boundaries dialog box, as shown below. Use the dropdown boxes to select the upper and lower boundaries of the data’s size range that will be viewed. Data is displayed between the selected boundaries and statistics are computed based on the range of data between the boundaries. Select **Max View** to include all data.

In the graph window, you can drag view boundaries by positioning the cursor on the boundary you want to change, clicking the left mouse button, and dragging the view boundary to the new location. If the **View Range = Valid Range** box is checked, the boundaries cannot be changed.

![View Boundaries Dialog Box](image)

**Figure 4-11** View Boundaries Dialog Box

**Graph Type**

Select **Format | Graph Type** to select the type of graph to display in the active window. The options are bar, line, or area. If the Graph toolbar is visible, you can select the option using the appropriate icon.

- ![Bar Graph](image) Display graphs using bars.
- ![Line Graph](image) Display graphs using lines.
- ![Area Graph](image) Display graphs showing area.
Grid Lines

Select **Format | Grid Lines** to select the lines for the graph in the active window. The options are horizontal, vertical, both or none. If the Graph toolbar is visible, you can select the option using the appropriate icon.

- Display graphs with no grid.
- Display graphs with a horizontal grid.
- Display graphs with a vertical grid.
- Display graphs with both horizontal and vertical grids.

Color

Select **Format | Color** to change the colors used to display items in the active window.

When you select **Format | Color**, the Graph Color or Table Color window opens depending on the active window on the desktop (Figure 4-12 shows both). These windows include a preview screen, a drop down list and a color palette. From the drop down list, select the name of the item you want to modify. The current color for that item is indicated in the color palette. Use the mouse to point to the new color for that item and click the left mouse button to select it. The preview screen then displays the item in the new color.
Select items from the drop down list and colors as desired. When finished, press **OK**; the colors you selected will be used from that point on in all graphs and/or tables.

The items you can select for windows containing graphs are:

- Window Background
- Plot Area Background
- Labels
- Axis
- Data
- Valid Boundaries
- Channel View Boundaries
- Impactor Cutoff Line
- Data Hotspot Lines
The items you can select for windows containing tables are:

- Window Background
- Cell Text
- Grid Color
- Cell Background
- Fixed Area Text

**Font**

Select the **Format|Font** menu to change the style and size of the text in all graphs or tables.

Select **Format|Font|Style**... to select a new font or change the font style, see Figure 4-13. You can select any font and font style available on your computer. The preview box lets you see what the text will look like before you implement it by selecting **OK**.

![Font Dialog Box](image)

**Figure 4-13**
The Font Dialog Box

To change the font size, select **Format|Font|Small, Medium, or Large** (the default is Medium). To change the text size without using the menus, select the **A** icon from the toolbar. Each time you select the icon the text size changes to the next text size. (Rotation is from small to medium to large.)

**Undo Zoom**

Select **Format|Undo Zoom** to return a graph to its “normal” viewing size after you have zoomed in on a portion of the graph. See “**Zoom In and Out on Data in a Graph**” in Chapter 3.
View Menu

The list of items in the View menu depends on which windows are open on the desktop and which one is active. The View menu lets you select the sample windows to open on the desktop and select parameters to view in those windows. A checkmark next to an item indicates the item has already been selected. Look under the Windows menu to find the item and make it the active window.

<table>
<thead>
<tr>
<th>View</th>
<th>Sample</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Weight</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size Data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Raw Data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Statistics</td>
<td>F3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Settings</td>
<td>F4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sample</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reference</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sample</td>
<td>Reference</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sample</td>
<td>Reference</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toolbars</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 4-14
View Menu for an SMPS Spectrometer

Units

The Units menu item appears when a size data graph, table, or statistics window is active on the desktop. This menu item works in conjunction with the Weight menu item, and lets you choose the units in which data will be displayed.

Unit selections include:

<table>
<thead>
<tr>
<th>View</th>
<th>Sample</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Weight</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size Data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Raw Data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Statistics</td>
<td>F3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 4-15
Units Selection Menu

The currently selected unit is marked with a check mark. This was set by selecting View|Units|dW/dlogDp.
Table 4-5 gives an explanation of each unit.

**Table 4-5**

<table>
<thead>
<tr>
<th>View Units</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dW/dlogDp</td>
<td>This option displays differential or normalized particle size distribution, normalized to one decade of particle size. This normalized concentration format allows particle size distributions to be compared regardless of the channel resolution. ( \frac{dW}{d \log \text{Dp}} = \frac{dW}{\text{resolution}} ) in channels/decade. ( W ) represents the weighting of the distribution, which can be N (number), S (surface area), V (volume), or M (mass).</td>
</tr>
<tr>
<td>Concentration (dW)</td>
<td>This option displays interval particle size distributions. The concentration in any channel represents the concentration within the particle size boundaries for that channel. ( W ) represents the weighting of the distribution, which can be N (number), S (surface area), V (volume), or M (mass).</td>
</tr>
<tr>
<td>% Concentration</td>
<td>This option displays each particle size channel as a percentage of the total particle concentration.</td>
</tr>
<tr>
<td>Cumulative Conc.</td>
<td>This option displays the particle concentration in a cumulative or summed format. Each particle size channel represents the total concentration of particles measured below its upper size boundary.</td>
</tr>
<tr>
<td>Cumulative % Conc.</td>
<td>This option is the same as Cumulative Conc., but displayed as a percentage of the total concentration.</td>
</tr>
<tr>
<td>Raw Counts</td>
<td>Raw Counts are the lowest level of data representation, raw detected particle counts put into channels by size, but without any corrections. Mapping of particle size within the program can cause single counts to be split across two channels.</td>
</tr>
</tbody>
</table>

Figure 4-16 shows a data graph from an SMPS spectrometer.
Figure 4-16
Electrical Mobility Diameter Data Displayed in %Concentration

Weight

The Weight menu item appears only when a graph window is active on the desktop. This menu item works in conjunction with the Units menu item and lets you choose how to “weight” the units that are displayed.

You can select:

Figure 4-17
Weight Menu

The currently selected weight is marked with a check mark. Table 4-6 gives an explanation of each unit.
<table>
<thead>
<tr>
<th>View Units</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Number represents the total number of particles per unit volume of air sampled (i.e., number concentration expressed as #/cm$^3$). Number concentration is the primary measurement of the SMPS system. The spectrometer is sensitive to the number of particles in the aerosol sample as opposed to the particle mass, color, shape, composition or other characteristic. The distributions of diameter, surface area, volume or mass concentrations of the particles are calculated based on the particle number distribution. The number concentration, dN, measured by the SMPS spectrometer is the concentration of particles in a given channel. The normalized number concentration, dN/dlogDp, is calculated by dividing dN by the geometric width of the size channel.</td>
</tr>
<tr>
<td>Diameter</td>
<td>Diameter represents the first moment of the diameter, or the total of all particle diameters per unit volume of air sampled, in units of mm/cm$^3$. Diameter moment is calculated by: $dD = dN \cdot D_p$, where $D_p$ is the geometric midpoint of the particle size channel. The normalized diameter concentration is: $dD/d\log D_p = dN/d\log D_p \cdot D_p$.</td>
</tr>
<tr>
<td>Surface</td>
<td>Surface represents the total surface area of the particles per unit volume of air sampled (i.e., surface area concentration expressed as nm$^2$/cm$^3$). The surface area concentration calculation assumes that all the particles are perfect spheres. Surface area concentration is calculated by: $dS = dN \cdot \pi D_p^2$, where $D_p$ is the geometric midpoint of the particle size channel. The normalized surface concentration is: $dS/d\log D_p = dN/d\log D_p \cdot \pi D_p^2$.</td>
</tr>
<tr>
<td>Volume</td>
<td>Volume represents the total volume of the particles per unit volume of air sampled (i.e., volume concentration expressed as nm$^3$/cm$^3$). The volume concentration calculation assumes that all the particles are perfect spheres. Volume concentration is calculated by: $dV = dN \cdot (\pi/6) D_p^3$, where $D_p$ is the geometric midpoint of the particle size channel. The normalized volume concentration is: $dV/d\log D_p = dN/d\log D_p \cdot (\pi/6) D_p^3$.</td>
</tr>
</tbody>
</table>
View Units | Description
--- | ---
Mass | Mass represents the total mass of the particles per unit volume of air sampled (i.e., mass concentration expressed as µg/cm³). The mass concentration calculation assumes that all the particles are perfect spheres with the density defined in the Run/Properties dialog for the instrument.

Mass concentration is calculated by:
\[ dM = dN \cdot \left(\frac{\pi}{6}\right)D_p^3 \rho, \]
where \( D_p \) is the geometric midpoint of the particle size channel and \( \rho \) is the density. This quantity is related to Volume concentration by the simple factor \( \rho \). The normalized mass concentration is:
\[ \frac{dM}{d\log D_p} = \frac{dN}{d\log D_p} \cdot \left(\frac{\pi}{6}\right)D_p^3 \rho. \]

In many of the tables, the values for all four weightings are supplied in tabular format.

**Note:** Surface, Mass and Volume weighting calculations assume that all the particles are spherical. Mass calculations also assume that all particles have the density defined in the properties dialog for the instrument. However, comparisons to methods that measure particle surface, volume or mass directly may give results different from those calculated by the software.

Figure 4-18 shows size data in units of cumulative % concentration weighted by mass.

![Figure 4-18](image)

**Size Data**

Select **View|Size Data** to open a graph or a table window that displays the file’s sample data based on size.
Raw Data

Select View|Raw Data to open a graph or a table window that displays the raw data of the active sample.

Molecular Mass (macroIMS only)

Select View/Molecular Mass to open a graph of sample data plotted versus molecular mass in kilodaltons.

**Note:** The Molecular Mass axis is intended for displaying results of macromolecule measurements made using macroIMS, or Macroion Mobility Spectrometer™. The macroIMS combines the Model 3936N76 or 3936N86 SMPS spectrometer with the Model 3480C Charge-reduced Electrospray Ionization (ESI) Source to generate, size and quantify singly-charged individual macromolecules from liquid samples. The Molecular Mass axis is calculated assuming all particles are spherical with the density defined in the Properties dialog for the instrument. The dalton is a unit equal to one atomic mass unit (amu), or $1.66057 \times 10^{-27}$ kg (carbon-12 scale).

Statistics

Select View|Statistics to open a window of statistical information for the active sample, see Figure 4-19. The equations used for calculating the values are described in Appendix C.

![Statistics Table](image)

**Figure 4-19**
Statistics Table
Settings

Select View|Settings to display the Properties settings for the SMPS spectrometer sample that is active on the desktop, as shown in Figure 4-20.

![Figure 4-20](image)

Select Settings to Display SMPS Settings for the Sample

Sample

Select View|Sample to view the current sample selected in the Samples List window.

Reference

Select View|Reference to view the reference buffer selected with Sample|Select as Reference.

Sample–Reference

Select View|Sample-Reference to view the current sample minus (–) the reference sample. This menu item is not available if no sample has been selected as a reference using Sample|Select as Reference.

Sample–Reference is only allowed for the following units: Concentration (dW), dW/dlogDp, and Cumulative Conc.
Sample/Reference

Select View|Sample/Reference to view the current sample divided by (/) the reference sample. This menu item is not available if no sample has been selected as a reference using Sample|Select as Reference.

Sample/Reference is only allowed for the following units: Concentration (dW), dW/dlogDp, and Cumulative Conc.

Note: Statistics are not calculated for this option. All fields in the table will be blank.

Copy

Select View|Copy or from the toolbar to copy the active window so that you can "paste" it in other applications, for example a word processing program.

Toolbars

Select View|Toolbars to display or hide the toolbars that appear on the desktop. Each toolbar is illustrated below:

- **Main Toolbar**
- **Color and Font Toolbar**
- **Graph Toolbar**
- **Navigation Toolbar**

The Data Merge icon appears on the main toolbar if the appropriate software has been installed. See Chapter 2, "Installing the Software" for more information.

By default, only the Main and Navigation toolbars are displayed.

To view what each icon (tool) does, position the cursor on the icon. A balloon appears describing the function of the icon.

Toolbars can be moved and resized if desired. To move a toolbar, position the cursor on a gap between two tools and press and hold the left mouse button. As you move the mouse, the toolbar moves with it. To resize a toolbar, position the cursor at an edge or corner of the toolbar window that you have moved and resize it as desired.
You can hide a toolbar by selecting the “x” in the upper right corner.

Sample Menu

The Sample menu lets you navigate through files with multiple samples and select and clear a reference sample.

*Note:* You can also navigate through files with multiple samples using the Navigation toolbar.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beginning Sample</td>
<td>Alt+B</td>
<td></td>
</tr>
<tr>
<td>Previous Sample</td>
<td>Alt+P</td>
<td></td>
</tr>
<tr>
<td>Next Sample</td>
<td>Alt+N</td>
<td></td>
</tr>
<tr>
<td>Ending Sample</td>
<td>Alt+E</td>
<td></td>
</tr>
<tr>
<td>Delete/Undelete Sample</td>
<td>Del</td>
<td></td>
</tr>
<tr>
<td>Select As Reference</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear Reference Buffer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl+A</td>
<td></td>
</tr>
</tbody>
</table>

Figure 4-21
Sample Menu

Beginning Sample

Select Sample | Beginning Sample or ![left arrow] from the toolbar to display the data for the first sample of the file in the active window.

Previous Sample

Select Sample | Previous Sample or ![left arrow] from the toolbar to display the data for the previous sample of the file in the active window.

Next Sample

Select Sample | Next Sample or ![right arrow] from the toolbar to display the data for the next sample of the file in the active window.

Ending Sample

Select Sample | Ending Sample or ![right arrow] from the toolbar to display the data for the last sample of the file in the active window.
Delete/Undelete Sample

Select **Sample|Delete/Undelete Sample** to mark a sample for deletion or to unmark a sample that has been previously marked for deletion. Sample data that is marked as deleted are not physically deleted from the file until you select **File|Save** or **File|Close**.

Select As Reference

Select **Sample|Select As Reference** to select the current sample as a reference sample. This sample can then be subtracted from the current sample or you can divide the current sample by the reference sample. Refer to the View menu items above.

Clear Reference Buffer

Select **Sample|Clear Reference Buffer** to clear the reference buffer.

Select All

Select **Sample|Select All** to select (highlight) all samples in the Samples List window for playback or exporting. This item is only available when the Samples List window is the active window.

Window Menu

The Window menu items let you open, close and arrange the windows on your desktop. Refer to your Windows documentation for an example of what each command does.

<table>
<thead>
<tr>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-Pane Layout</td>
<td>Ctrl+K</td>
</tr>
<tr>
<td>4-Pane Layout</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Cascade</td>
<td></td>
</tr>
<tr>
<td>Tile Horizontal</td>
<td></td>
</tr>
<tr>
<td>Tile Vertical</td>
<td></td>
</tr>
<tr>
<td>Close All</td>
<td></td>
</tr>
</tbody>
</table>

1 Statistics Table [Outdoor Air.S80]
2 Size Data Table [Outdoor Air.S80]
3 Size Data Graph [Outdoor Air.S80]
4 SMPS Settings [Outdoor Air.S80]
5 SMPS - Samples List [Outdoor Air.S80]

Figure 4-22
Window Menu
All windows on the desktop, whether active or inactive, are listed after the Close All command; the active window is shown with a check mark. To make a different window active and bring it to the front, select it with the mouse.

**Help Menu**

The Help menu provides access to information about the program.

<table>
<thead>
<tr>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Aerosol Instrument Manager…</td>
</tr>
<tr>
<td>Help Manual</td>
</tr>
</tbody>
</table>

| F1              |

Figure 4-23
Help Menu

**About Aerosol Instrument Manager**

Select *About Aerosol Instrument Manager* to see the copyright statement for the program and view the version number of the software.

**Help Manual**

Select **Help|Help Manual** to see the manual of the Aerosol Instrument Manager software for SMPS.
# Status Bar Icons

A status bar at the bottom of most windows provides information about what is being shown in the window as well as information about what operations are occurring.

Each icon is described below:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Attention. The scan returned with one or more status flags set. Move the mouse over the icon to view the tool tip which displays the status text.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Charge correction is off.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Charge correction is on.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Diffusion correction is on.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Nanoparticle aggregate mobility analysis is on.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Down scan in progress.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Up scan in progress.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Scan completed without problems.</td>
</tr>
</tbody>
</table>
APPENDIX A

Data Files, Project Files, and Stored Parameters

The Aerosol Instrument Manager stores data in two types of files: data files and project files. This appendix describes those files and the parameters stored in them. In addition, it also describes the parameters stored in the aim.ini file.

Data Files and Project Files

The Aerosol Instrument Manager uses two types of files:

- Data files
- Project files

Data files contain sample data. They have a filename extension to indicate the type of spectrometer from which data was collected, such as .s80 for an SMPS spectrometer. Other information stored in data files includes:

Information stored for the whole file:
- Classifier model
- DMA model number and dimensions
- CPC model
- CPC 3022A high flow inlet flow rate
- Gas viscosity, temperature and pressure
- Mean free path
- Time file started

Information stored for each sample:
- Impactor type
- Aerosol and sheath flow rate
- Size range
- Voltage range
- Up scan and retrace time
- Down scan first (for 3071)
- Density
- td, tf, D_{50} of Impactor
Scans per sample
Time sample started
Status flags from the instrument
Instrument ID
Title and comment text

**Project files** are created by the program when you open a data file and work with it. They have an extension to indicate the type of spectrometer that they are the project files for (for example, .p80 for an SMPS spectrometer). Project files keep track of “cosmetic” attributes like which windows are open on the desktop when you close the file and how that information is displayed.

If you transfer data files to someone, you do not need to transfer the project files unless you want to. If you delete a project file, a new project file is created when you reopen the data file.

**Project File Parameters**

The following parameters are saved for each window (i.e., the Units for the Size Data table are stored for the Size Data table only, the Units for the graph are stored only for the graph):

- The graph type (bar, line, or area)
- The grid type (none, vertical, horizontal or both vertical and horizontal)
- Y axis scale parameters
- Units and weights selected
- List type, for the Samples List window
- Position and size of the window

The following parameters apply to the entire file (not to each individual window):

- Multiple charge correction
- View range
- Channel resolution
- Reference sample number and the way data is viewed compared to the reference buffer
- Playback delay time
- Current sample index (the sample number of the sample you were viewing when you exited the program)
Saved Parameters

The following parameters are stored for the Aerosol Instrument Manager application and are applied to all documents:

- Font and color for tables.
- Font and color for graphs.
- Aerosol Instrument Manager window size and position.

The following two items are also stored according to the instrument type selected.

- Window positions the last time a file was closed.
- Parameters from each different instrument Properties dialog box.
APPENDIX B
Accelerator Keys

Accelerator keys are those keys and key combinations that allow you to perform operations using only your keyboard (no mouse required).

These are the accelerator keys that can be used with your spectrometer.

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Action for SMPS Spectrometer</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td>F3</td>
<td>View statistics</td>
</tr>
<tr>
<td>F4</td>
<td>View settings</td>
</tr>
<tr>
<td>F5</td>
<td>View size data</td>
</tr>
<tr>
<td>Shift F5</td>
<td>View size data table</td>
</tr>
<tr>
<td>F6</td>
<td>View size data raw graph</td>
</tr>
<tr>
<td>Shift F6</td>
<td>View size data raw table</td>
</tr>
<tr>
<td>F10</td>
<td>Start sampling</td>
</tr>
<tr>
<td>Shift F10</td>
<td>Finish recording current sample</td>
</tr>
<tr>
<td>Alt B</td>
<td>Go to first sample “Begin”</td>
</tr>
<tr>
<td>Ctrl A</td>
<td>Select all in the Samples List window</td>
</tr>
<tr>
<td>Ctrl C</td>
<td>Copy current view to clipboard</td>
</tr>
<tr>
<td>Alt E</td>
<td>Go to last sample “End”</td>
</tr>
<tr>
<td>Ctrl K</td>
<td>Arrange windows in 2-pane layout.</td>
</tr>
<tr>
<td>Ctrl L</td>
<td>Arrange windows in 4-pane layout</td>
</tr>
<tr>
<td>Alt N</td>
<td>Next sample</td>
</tr>
<tr>
<td>Ctrl N</td>
<td>New document</td>
</tr>
<tr>
<td>Ctrl O</td>
<td>Open a document</td>
</tr>
<tr>
<td>Alt P</td>
<td>Previous sample</td>
</tr>
<tr>
<td>Ctrl P</td>
<td>Print current view</td>
</tr>
<tr>
<td>Ctrl R</td>
<td>Display sample properties</td>
</tr>
<tr>
<td>Ctrl S</td>
<td>Save</td>
</tr>
<tr>
<td>Z</td>
<td>Undo Zoom in graph</td>
</tr>
</tbody>
</table>
APPENDIX C
Calculations Used for SMPS™ Spectrometer

This appendix gives an explanation of the statistics calculations used by the Aerosol Instrument Manager® Software. The statistics are calculated for the interval defined by the upper and lower bounds selected from the graphs, which are not necessarily the entire size range of the instruments.

<table>
<thead>
<tr>
<th>Statistic/Weight</th>
<th>Number</th>
<th>Surface Area</th>
<th>Volume</th>
<th>Mass</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concentration</td>
<td>( n = \frac{c \phi}{iQ \eta} )</td>
<td>( s = \pi D_p^2 \eta )</td>
<td>( v = \frac{\pi D_p^3 \eta}{6} )</td>
<td>( m = \rho v )</td>
</tr>
<tr>
<td>Total Concentration</td>
<td>( N = \sum_{l} )</td>
<td>( S = \sum_{l} s )</td>
<td>( V = \sum_{l} v )</td>
<td>( M = \sum_{l} m )</td>
</tr>
<tr>
<td>Mode</td>
<td>( D_p(n_{\text{max}}) )</td>
<td>( D_p(s_{\text{max}}) )</td>
<td>( D_p(v_{\text{max}}) )</td>
<td>( D_p(m_{\text{max}}) )</td>
</tr>
<tr>
<td>Median (( \bar{x} ))</td>
<td>( D_p(N/2) )</td>
<td>( D_p(S/2) )</td>
<td>( D_p(V/2) )</td>
<td>( D_p(M/2) )</td>
</tr>
<tr>
<td>Mean (( \bar{x} ))</td>
<td>( \sum_{l} \frac{nD_p}{N} )</td>
<td>( \sum_{l} \frac{sD_p}{S} )</td>
<td>( \sum_{l} \frac{vD_p}{V} )</td>
<td>( \sum_{l} \frac{mD_p}{M} )</td>
</tr>
<tr>
<td>Geometric Mean (( \bar{x}_g ))</td>
<td>( \exp \left[ \frac{\sum_{l} n \ln D_p}{N} \right] )</td>
<td>substitute ( s, v, m ) and ( S, V, M ) in place of ( n ) and ( N ) for other weightings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Geometric Standard Deviation (( \sigma_g ))</td>
<td>( \exp \left[ \frac{\sum_{l} n \left[ \ln D_p - \ln \bar{x}_g \right]^2}{N} \right]^{1/2} )</td>
<td>substitute ( s, v, m ) and ( S, V, M ) in place of ( n ) and ( N ) for other weightings</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The symbols used in the formulas are defined as:

\[ c \] = particle counts per channel
\[ n \] = number weighted concentration per channel
\[ s \] = surface area weighted concentration per channel
\[ v \] = volume weighted concentration per channel
\[ m \] = mass weighted concentration per channel
\[ \eta \] = sample efficiency factor per channel
\[ \phi \] = sample dilution factor
\[ D_p \] = particle diameter (channel midpoint)

\[ C \] = total particle counts
\[ N \] = total number concentration
\[ S \] = total surface area concentration
\[ V \] = total volume concentration
\[ M \] = total mass concentration

\[ Q \] = sample flow rate
\[ t \] = sample time
\[ \rho \] = particle density
\[ ln \] = natural log
\[ exp \] = base of natural log (e)
\[ l \] = lower channel boundary
\[ u \] = upper channel boundary
APPENDIX D
SMPS™ Software Comparison

The calculations performed by the Aerosol Instrument Manager version of the SMPS software are essentially the same as those used in the original versions of the Windows SMPS software. Some small changes were made that will slightly affect the measurement results as compared to the original Windows SMPS software. These are:

- **Cunningham Slip Correction.** The calculation of the slip correction is given by:

  \[ C_c = 1 + \frac{2\lambda}{D_p}(1.142 + 0.558e^{-0.999D_p}) \]

  This calculation is used uniformly throughout the SMPS program. In the Windows version of the SMPS software, two different equations were used. One is used in calculating the particle charge probability table and the other is used in the calculation of particle size.

- **Boundary Calculations.** The original Windows SMPS software was not consistent in its use of particle diameter boundaries versus diameter midpoints when calculating the starting and stopping voltages for the measurement scan. This small inconsistency has been corrected in the Aerosol Instrument Manager software and the measurement scan now correctly starts at the lower boundary of the first channel to be measured and ends at the upper boundary of the last (largest) diameter channel. Both programs calculate the measurement scan range based on channels binned to 64 channels per decade of particle size.

- **Constants.** The value for mean free path was changed from 6.53e-8 m to 6.65e-8 m. The value for gas viscosity was changed from 1.834e-5 to 1.8203e-5. Both of these parameters can be adjusted in the properties dialog of the Aerosol Instrument Manager SMPS software.
- **Round-off Error on Starting Voltage.** It was discovered that the starting and stopping voltage scanning parameters delivered to the CPC were truncated rather than properly rounded-off to the appropriate value. This has little effect on the stopping voltage value, which is typically large compared to the truncation error. However, at the stating voltage, which can be as low as 10 volts, the truncation error is significant. While the new SMPS software now properly rounds the result, the CPC continues to take only integer values of voltage as parameters so some error still exists. When possible, the user should use higher flow rates and a smaller DMA (such as the Model 3085 Nano DMA) to raise the starting voltage for smaller particles, thus reducing any errors from the round-off.
APPENDIX E

Sequence Files

The files for sample sessions that run past midnight (or run for more than 24 hours) are handled differently than those that start and stop on the same date. (Midnight occurs on your system according to the setting of your computer's system clock.)

For these sample sessions, a sequence of files is created, with each file in the sequence given a unique filename extension identifying its proper order.

Normally, only a single file is created for any sample session and it has a filename extension of the form .s80. For example, Atmosphere.s80, which would identify the file as an SMPS file.

If the sample session period runs past midnight, a file is created for each date (day). The samples collected before midnight (including the sample that is running at midnight) are collected in a file with the normal extension, i.e., .s80

Samples that are collected after midnight are saved in a file with an extension of the form ".1.s80". (Using the same example as above, the next filename would be "Atmosphere.1.s80.")

For a very long sample session, a file is created each time the sample session runs past midnight and is indicated by adding a new number to the file extension. Using the previous example, the file following "Atmosphere.1.s80" is "Atmosphere.2.s80" and the next file would be "Atmosphere.3.S80" and so on.

These files contain information to link them when opened and the files can be recalled as if they were a single file. The files may also be selected and opened as individual files.

When you save the samples collected during a sample session that runs past midnight, you provide a filename just as you would for any sample session. You do not provide any extensions. The software automatically adds a file extension.
Opening a File That is Part of a Sequence

If you select **File|Open** and the file is part of a sequence of files (i.e., the sample session ran over midnight), the following dialog box appears:

![File Question? Dialog Box](image)

**Figure E-1**
File Question? Dialog Box

You have the option of opening all the files or only a single one.

If you select **No**, only the file you have selected will open and only the samples in that file will be available to you.

If you select **Yes**, all files in the sequence will open and the samples from the entire session are available as if you had opened a single file.

**Note:** If you select **View|Samples List|Details**, you can see the pathname for each sample.

When you open a sequence of files, the software looks for the first file of that sequence (i.e., the one with the .s80 extension and opens all files in sequence beginning with that file). If a sequence file is unavailable (for example, it has been deleted, moved or corrupted), the software opens the files until it comes to the missing file. For example, if you try to open a sequence of files that contains seven files and the fourth file is missing, only the first three files can be opened. Files five, six, and seven are “orphaned.” These remaining files (5, 6, and 7) can only be opened individually, not as a sequence.
This appendix lists the messages you may encounter when using the software and suggests the action you should take.

### Table F-1
Error Messages for SMPS Spectrometer

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;file&gt;</code> already exists. Do you want to append to it?</td>
<td>The text file selected already exists. New exported data will be appended to the end of the file.</td>
</tr>
<tr>
<td>0 is invalid when using a log y scale</td>
<td>You must enter a number greater than zero to proceed.</td>
</tr>
<tr>
<td>0 is not valid for the maximum value</td>
<td>You must enter a number greater than zero to proceed.</td>
</tr>
<tr>
<td>Aerosol Flow Rate must be &gt;= 0.1</td>
<td>Error in the Properties</td>
</tr>
<tr>
<td>All of the necessary settings have not been selected. (You cannot exit the</td>
<td>Error in the Properties</td>
</tr>
<tr>
<td>hardware settings page until all of the fields are set.)</td>
<td></td>
</tr>
<tr>
<td>Cannot calculate a valid size range with the current Gas Viscosity and/or</td>
<td>Incorrect values were entered in the Properties</td>
</tr>
<tr>
<td>Mean Free Path values.</td>
<td></td>
</tr>
<tr>
<td>Cannot close the Aerosol Instrument Manager database.</td>
<td></td>
</tr>
<tr>
<td>Cannot communicate with the instrument. Please check that it is connected,</td>
<td>Communications error, the software cannot communicate with the hardware. Please check the items indicated in the message.</td>
</tr>
<tr>
<td>turned on, has the correct comm settings set in the properties, and that the</td>
<td></td>
</tr>
<tr>
<td>port is not in use by another application</td>
<td></td>
</tr>
<tr>
<td>Cannot find a file (&lt;filename&gt;) in the sequence of files associated with</td>
<td>Warning to let you know that the sequence of files has a gap and the program cannot load all of the files.</td>
</tr>
<tr>
<td>&lt;filename&gt;. Only the samples loaded will be available.</td>
<td></td>
</tr>
<tr>
<td>Cannot open the Aerosol Instrument Manager database.</td>
<td>Verify that the database file is not corrupted.</td>
</tr>
<tr>
<td>Cannot write to the Aerosol Instrument Manager database. Database connection</td>
<td></td>
</tr>
<tr>
<td>will be closed.</td>
<td>For information only.</td>
</tr>
<tr>
<td>Data Error. An incorrect amount of data was received in the current run.</td>
<td></td>
</tr>
<tr>
<td>Sampling was stopped and excess data, if any, was ignored.</td>
<td></td>
</tr>
<tr>
<td>Fixed Scale is selected. You must select a Minimum and/or Maximum value.</td>
<td>If you want to use the fixed scale parameter, you must select a minimum or maximum value.</td>
</tr>
<tr>
<td>Gas Viscosity cannot be zero</td>
<td>Incorrect values were entered in the Properties</td>
</tr>
<tr>
<td>Gas Viscosity must be &lt; 1.0. Make sure the units are correct</td>
<td>Incorrect values were entered in the Properties</td>
</tr>
<tr>
<td>Error Message</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Log y scale is invalid because the minimum y scale value is set to 0</td>
<td>You have tried to select log Y scale and you also have 0 as the fixed minimum value. You cannot have both selected. Change one.</td>
</tr>
<tr>
<td>Maximum value must be &gt; minimum value.</td>
<td>You have entered a minimum value that is greater than the maximum value. Reenter the correct values.</td>
</tr>
<tr>
<td>Mean Free Path cannot be zero</td>
<td>Incorrect values were entered in the Properties</td>
</tr>
<tr>
<td>Mean Free Path must be &lt; 1.0. Make sure the units are correct</td>
<td>Incorrect values were entered in the Properties</td>
</tr>
<tr>
<td>Retrace time must be &gt;= 10</td>
<td>Error in the Properties</td>
</tr>
<tr>
<td>Sample #x will be discarded and cannot be recovered. Do you want to discard it?</td>
<td>Answer yes if you want to permanently remove the sample from the file.</td>
</tr>
<tr>
<td>The CPC efficiency file is missing. All 1’s will be used for data correction.</td>
<td>The efficiency file is needed to correctly convert the raw data to raw counts. The file needs to be in the same directory as the aim.exe file.</td>
</tr>
<tr>
<td>The CPC is reporting a fault. Do you want to start sampling anyway?</td>
<td>Select OK to continue.</td>
</tr>
<tr>
<td>The CPC Model 3022A Inlet Flow Rate applies to all samples in the data file. Are you sure you want to change the Inlet Flow Rate</td>
<td>Incorrect values were entered in the Properties</td>
</tr>
<tr>
<td>The CPC Model applies to all samples in the data file. Are you sure you want to change the CPC Model?</td>
<td>Incorrect values were entered in the Properties</td>
</tr>
<tr>
<td>The current td value was set by the user, do you want to recalculate using new parameters?</td>
<td>Incorrect values were entered in the Properties</td>
</tr>
<tr>
<td>The user efficiency file is missing. All 1’s will be used for data correction.</td>
<td>The efficiency file is needed to correctly convert the raw data to raw counts. The file needs to be in the same directory as the aim.exe file.</td>
</tr>
<tr>
<td>The file selected is not a valid SMPS data file.</td>
<td>The imported data file must be from version 3.1 or earlier of the TSI SMPS software.</td>
</tr>
<tr>
<td>The file you have selected is part of a sequence of files. Do you want to view all the files?</td>
<td>You have selected a file that is part of a sequence of files. You can select Yes to view all the files or No to view only the file you initially selected.</td>
</tr>
<tr>
<td>The size range is invalid for the selected Gas Viscosity and/or Mean Free Path values. Do you want to recompute the size range based on the new values?</td>
<td>Incorrect values were entered in the Properties</td>
</tr>
<tr>
<td>The starting hour is invalid</td>
<td>Properties</td>
</tr>
<tr>
<td>The upper size must be greater than the lower size</td>
<td>Reenter the values.</td>
</tr>
<tr>
<td>The User Defined intersample time is less than the sample length</td>
<td>Properties</td>
</tr>
<tr>
<td>The voltage range is invalid. Do “Set to Max Range”</td>
<td>The voltage range is 10 – 10,000 for the 3080 classifier and 10 – 11000 for the 3071 classifier.</td>
</tr>
<tr>
<td>This sample is the Reference sample. Do you want to discard the sample?</td>
<td>Select OK to discard the sample.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unable to create the graph control.</td>
<td>The graph control OCX is not registered properly on your system. Contact TSI for support.</td>
</tr>
<tr>
<td>Up Scan time must be at least 2*Retrace time</td>
<td>Error in the Properties</td>
</tr>
<tr>
<td>Upper channel boundary must be larger than lower channel boundary.</td>
<td>You have selected a channel boundary for the upper channel that is lower than the channel boundary for the lower channel. You must select a channel boundary that is higher than the lower channel.</td>
</tr>
<tr>
<td>You cannot close while writing to the database.</td>
<td>Wait until the data is written to the database and then close the file.</td>
</tr>
<tr>
<td>You must enter a maximum value</td>
<td>You must enter a maximum value to proceed.</td>
</tr>
<tr>
<td>You must enter a minimum value</td>
<td>You must enter a minimum value to proceed.</td>
</tr>
</tbody>
</table>
APPENDIX G

Scanning Mobility Particle Sizer™ (SMPS™) Spectrometer Diffusion Loss Correction

Why Are Diffusion Losses Important in the SMPS?

To understand why we need a Diffusion Loss Correction, it is necessary to recall three facts:

1) When aerosol particles collide with a surface they adhere due to van der Waals force, electrostatic force and surface tension.

2) Diffusion is the primary transport mechanism for particles smaller than 0.1 µm (100 nm).

3) The smaller the particle the more rapid the diffusion.

Thus, if an aerosol particle diffuses to the wall of its measurement flow path, there will be diffusion losses, and the measured size distribution will under represent small particles. Since the Scanning Mobility Particle Sizer™ (SMPS™) spectrometer measures particles in the size range of 2.5 nm–1000 nm, diffusion losses are unavoidable. They are however, quantifiable.

Diffusion losses are frequently characterized in terms of penetration (P) through a tube: 

\[ P = \frac{n_{\text{out}}}{n_{\text{in}}} \]

Penetration is a function of the particle diffusion coefficient (D), length of the tube (L), and volumetric flow rate (Q). The Diffusion coefficient (D) is affected by temperature, gas medium, and particle diameter.
Circular Tube Penetration Efficiency

![Graph showing Circular Tube Penetration Efficiency](image)

**Figure G-1**
Circular Tube Penetration Efficiency [Gormley and Kennedy (1949)]

Note that the diffusion loss through a tube (for a fixed volumetric flow rate) is not a function of tubing diameter. The additional distance the particles must travel to the walls in a wider tube is offset by a longer residence time.

---

**How Can You Characterize Diffusion Losses in the SMPS?**

The Scanning Mobility Particle Sizing™ (SMPS™) spectrometer can be broken down into five different flow paths for which an aerosol penetration can be calculated.

- \( P_1 \) = Penetration through the impactor inlet
- \( P_2 \) = Penetration through the bi-polar neutralizer and internal plumbing
- \( P_3 \) = Penetration through the tubing to the Differential Mobility Analyzer (DMA) and CPC
- \( P_4 \) = Penetration through the DMA
- \( P_5 \) = Penetration through the CPC
The total penetration through the system is the product of the individual penetration values:

\[ P_{total} = P_1 P_2 P_3 P_4 P_5 \]

**Determination of \( P_1 \)**

The penetration through the impactor assembly was determined experimentally using all three impactor sizes (0.0457 cm, 0.0508 cm, & 0.071 cm) and a variety of flow rates. \( P_1 \) is dependent on the Reynolds number so it is affected by the flow rate and the gas properties of the working gas. When using an impactor, it is important to stay within the recommended flow ranges to achieve the highest accuracy for the Diffusion Loss Correction.

**Determination of \( P_2 \)**

The penetration through the internal passages of the Model 3080 Classifier (including the Model 3077/3077A neutralizer) was determined experimentally at a variety flow rates. \( P_2 \) is a function of the particle diffusion coefficient and flow rate.
**Note:** Diffusion Loss Correction was designed to be used with the Model 3080 Classifier Platform.

**Determination of P₃**

Penetration through the connecting tubing was calculated using Gormley and Kennedy’s equations for penetration through a circular tube¹.

**Determination of P₄**

Penetration through each of the Differential Mobility Analyzers (Model 3085 and Model 3081) was determined using published data²,³,⁴ on the transfer functions for these DMAs and was also validated experimentally.

**Determination of P₅**

P₅ is the counting efficiency of the CPC and includes penetration inside the CPC, activation efficiency and optical detection efficiency.

**Note:** All of the experiments were performed using air at Standard Temperature & Pressure (STP) as the working gas. Since diffusion losses are a function of the particle diffusion coefficient (D) and D is a function of the working gas properties, the use of different working gases and/or conditions will result in an error in the calculated diffusion loss. It is possible to input gas properties in the software to increase the Diffusion Loss Correction accuracy, but other working gases and conditions have not been experimentally verified.

---

**How Does It Work?**

Simply open the SMPS Properties box in the Aerosol Instrument Manager™ Software and under *Correction Flags and Values* check the *Diffusion Correction* box and enter the carrier gas density (the default value is the density of air).

**Note:** The correction can be toggled on and off and can be applied to previously collected data similar to Charge Correction.
Below is a Scanning Mobility Particle Sizer™ Spectrometer (SMPS™) data file of outdoor air illustrating Diffusion Loss Correction. Diffusion losses are highly dependent on sample flow rate and particle size. This data was taken using a very low flow rate, so it is close to a “worst case scenario.”
**When Should I Use Diffusion Loss Correction?**

**Ultrafine Particles**

It is especially important to use Diffusion Loss Correction when sizing aerosols smaller than 100 nm, since in this size regime diffusion becomes increasingly significant. The correction is negligible for aerosols larger than 100 nm.

**Low Flow Rates**

Sampling at low flow rates will also aggravate diffusion losses.

It is recommended to toggle the Diffusion Loss Correction and observe the magnitude of the correction whenever viewing data.

---

**Free Upgrade**

TSI is offering Diffusion Loss Correction as a free upgrade to the Aerosol Instrument Manager™ software. To receive your upgrade please contact TSI at particle@tsi.com with the instrument model numbers and serial numbers of your component SMPS system.
Note: Diffusion Loss Correction is not currently available for the Model 3034 Single-Box Scanning Mobility Particle Sizer™ Spectrometer.

References


APPENDIX H

Scanning Mobility Particle Sizer™ (SMPS™) Spectrometer Nanoparticle Aggregate Mobility Analysis Software Module

Introduction

Urban ultrafine atmospheric aerosol and particle emissions from combustion sources such as diesel engines are typically low fractal dimension aggregates \((D_f \leq 2)\) composed of spherical primary particles with diameter 5-50 nm. The nanoparticle aggregates are also present in several nanomaterial production processes such as manufacturing carbon black, titania and fumed silica. TSI Scanning Mobility Particle Sizer™ (SMPS™) spectrometer is commonly used to measure size distributions for these applications and more. The SMPS spectrometer uses electrical mobility to measure the particle size. This technique utilizes a bipolar charger to impart a known charge distribution on the aerosol sample. The particles are then classified according to their ability to traverse an electric field. The most common method of interpreting electrical mobility analysis to obtain size (in the SMPS, as well as other commercially available electrical mobility analyzers), is based on a spherical particle model, including an expression for the drag coefficient over a wide range of Knudsen numbers \((Kn)\) and the bipolar charging efficiency of spherical particles. While this method is appropriate for sizing spherical particles, it leads to errors in the mobility size data interpretation for aggregates, and subsequent calculations of surface area and volume (and hence mass) distributions.

A new method for analyzing mobility of nanoparticle aggregates for a limiting case of idealized aggregates \((D_f \leq 2)\) has been developed (Lall and Friedlander, 2006 a) and has been recently incorporated
in the Aerosol Instrument Manager® Software (version 8.0) for TSI Model 3936 series SMPS. This method yields a more accurate estimate of the number, surface area and volume distributions of nanoparticle aggregates. The mobility of aggregates measured by an SMPS is processed by a two module approach: *one module for the drag on the aggregates and the other for aggregate charging efficiency*. This method requires the user to input the average primary particle size of the aggregate. The average primary particle size can be measured by electron microscopy or, if available, taken from published literature. The TSI Model 3089 Nanometer Aerosol Sampler in combination with the electrostatic classifier and Differential Mobility Analyzer (DMA) can be conveniently used to collect charged particles on a microscope grid for electron microscopy. Some literature resources for information on nanoparticle aggregate characteristics are papers by Barone *et al.* (2006), Xiong and Friedlander (2001), and Park *et al.* (2004 a, b).

This application note discusses the theory of idealized aggregates, basic assumptions and implementation in the new updated Aerosol Instrument Manager software module. We also discuss user operation of the software module and an example of analyzed data.

**Note:** The software module may be used for post-processing of collected SMPS data, including data previously collected by older versions of Aerosol Instrument Manager software.

## Theory

### Assumptions – Limiting Case of Idealized Aggregates

The nanoparticle aggregate mobility analysis software module analyzes the SMPS data for aggregate number, surface area and volume (mass) distributions based on certain assumptions. The basic assumptions used in the calculations are as follows:

1. Aggregates are composed of primary particles all of which have the same (known) diameter.
2. The primary particles that compose the aggregates are much smaller than the mean free path of the surrounding gas ($Kn >> 1$).
3. The total surface area of an aggregate can be obtained by summing over all primary particles in the aggregate. This is the maximum surface area which neglects the reduction due to necks between the primary particles.
4. Aggregates are “transparent”, that is, (nearly) all surfaces are directly exposed to collisions with molecules of a surrounding gas. This is an acceptable approximation for aggregates with fractal dimensions less than about two.
5. Two *singly* charged particles, an aggregate and a sphere, trace the same path in the classifier if their migration velocities are equal: Both are said to have the same mobility diameter. The Brownian diffusive spread is neglected.

6. Only ultrafine aerosol particles enter the mobility analyzer. Larger particles are removed by a device (e.g., an impactor) upstream of the SMPS.

**Calculations**

The nanoparticle aggregate mobility analysis method is organized into a two-module approach (as shown in Figure 1) for calculating aggregate number, surface area and volume distributions from DMA mobility data.

**Module 1: Aggregate Drag**

Consider an aggregate composed of \( N_p \) particles of radius \( \alpha \) and a spherical particle of diameter \( d_m \), both with unit charge. If the two have same migration velocity, then by equating the drag forces, we get

\[
\frac{d_m}{C(d_m)} = \frac{c^* N_p \alpha^2}{3\pi\lambda}
\]  

(1)

Where, \( C \) is the slip correction, \( c^* \) is the dimensionless drag force and \( \lambda \) is the mean free path of the gas. The value of \( c^* \) is 6.62 (Chan and Dahneke, 1981) for aggregates oriented parallel to the direction...
of motion relative to gas and 9.17 (Dahneke, 1982) for aggregates oriented perpendicular to the direction of motion. The method holds well for \( N_p > 10 \). For aggregates with \( D_f \leq 2 \), using equation 1, the number of primary particles in an aggregate with primary particle size in the free molecular regime can be related to the diameter of a sphere even in the transition regime (\( Kn \sim 1 \)).

**Module 2: Charging Efficiency**

The charging efficiency is the fraction of the particles of a given size that have a certain number of charges at equilibrium. The fraction of spheres and aggregates that assume unit charge after bipolar charging in general differ. Expressions for calculating the charge distributions are needed for both. The bipolar charging efficiency of spheres used in the Aerosol Instrument Manager software is given by the Fuchs charge distribution. The charging efficiency of aggregates, \( \eta_{agg} \) (Wen et al., 1984) is given as:

\[
\eta_{agg} = \frac{e}{(\pi D_{qe}kT)^{\frac{1}{2}}} \exp\left[-\frac{\left(n_p - \bar{n}_p\right)^2 e^2}{D_{qe}kT}\right]
\]

(2)

Where,
- \( n_p \) is the number of elementary charges
- \( \bar{n}_p \) is the median charge number
- \( e \) is the electronic charge
- \( k \) is the Boltzmann’s constant
- \( T \) is the absolute temperature
- \( D_{qe} \) is the charging equivalent diameter (\( N_p \geq 10 \))

\[
D_{qe} = \frac{2aN_p}{\ln(2N_p)}
\]

(3)

The median charge number is given by the following equation:

\[
\bar{n}_p = \frac{D_{qe}kT}{2e^2} \ln\left(\frac{N_+Z_+}{N_-Z_-}\right)
\]

(4)

Where,
- \( \frac{N_+}{N_-} \) is the ion concentration ratio
- \( \frac{Z_+}{Z_-} \) is the ion mobility ratio. For air, this ratio is usually taken to be 1.4/1.6

From equations 1 to 4, the charge distribution for aggregates can be determined as a function of the mobility diameter.
Number, Surface and Volume Distribution of Aggregates

Only a fraction of the charged particles pass through the DMA. The true number of spheres or aggregates is obtained by correcting for their charging efficiencies. For a given number of spheres or aggregates that are detected at the exit from the DMA per unit volume, the true number concentrations of aggregates and spheres will differ because of different charging efficiencies. The algorithm used to calculate the number distribution of aggregates \(n_{agg}\) from DMA mobility data is identical to the one used for spheres except aggregate charge distribution described in equation 2 is used instead of Fuchs charge distribution. Wang and Flagan (1990) describes in detail the data inversion algorithm used in the Aerosol Instrument Manager software to derive number based size distributions.

The surface area distribution \(A_{agg}\) with respect to the mobility diameter can be obtained from number distribution for aggregates from the expression:

\[
A_{agg}(d_m) = n_{agg}(d_m)N_p(d_m)4\pi a^2
\]  

(5)

Similarly, the volume distribution \(V_{agg}\) with respect to the mobility diameter can be obtained from the expression:

\[
V_{agg}(d_m) = n_{agg}(d_m)N_p(d_m)\left(4\pi a^3 / 3\right)
\]  

(6)

The theory of idealized aggregates has been experimentally verified by Lall et al. (2006 b).

Software Operation

The nanoparticle aggregate mobility analysis method is a part of the Aerosol Instrument Manager software for Model 3936 series SMPS. The user may select the nanoparticle aggregate mobility analysis by checking the appropriate box in the physical parameters tab of the software. The physical parameters tab is located in the “Properties” section under both the File and Run menus. This may be done either before or after data collection. To revert back to spherical analysis method, the user needs to uncheck the box. This type of user interface facilitates comparison of both types of data—data obtained with spherical model as well as the data analyzed by chain aggregate model.

Once the check box is checked, the user needs to input primary particle diameter (in units of nanometers) of the aggregate; the
default value is set to 10 nm. The user may also select the aggregate orientation (parallel or random with respect to the electric field). By default the software is set for parallel orientation. All electrically conducting aggregates tend to align parallel to the electric field due to the interaction of the induced dipole with the field (Stober, Boose, & Prodi, 1974). Diesel exhaust, ambient particles as well as most other ultrafine particles are conductive, and thus have parallel orientation.

![Software Interface](image)

**Figure H-2**
Physical Properties Tab of the Aerosol Instrument Manager Software Showing the Nanoparticle Aggregate Analysis Module User Interface.

The software module may be used for post-processing of previously collected SMPS data, including data previously collected by older versions of Aerosol Instrument Manager software. It simply provides an alternative processing of the same primary data.

**Example**

Figures 3a-c depict the comparison of number, surface area and volume based mobility diameter distributions, respectively, of diesel exhaust aggregates. The DMA calibration based on spherical particles is compared with the nanoparticle aggregate model based analysis using Aerosol Instrument Manager software. This example shows that the spherical model under estimates the surface area and greatly over estimates the volume (hence, mass) concentrations of diesel nanoparticle chain aggregates. The total number
concentration based on aggregate model was found to be in good agreement with that measured directly by a CPC (Lall et al., 2006 c).

![Graphs showing distribution functions](image)

**Figure H-3**
Aggregate distribution functions based on standard calibration for spheres (Red) compared with the distributions based on the idealized aggregate theory (Green). Primary particle diameter = 17 nm, aggregate orientation: parallel to the electric field. (a) Number Distributions, (b) Surface area distributions and (c) Volume distributions. Courtesy: Lall et al., 2006 c.

## Summary and Conclusions

A new method for nanoparticle aggregate mobility analysis for a limiting case of idealized aggregates ($D_f \leq 2$) has been developed. This method provides a more accurate estimate of number, surface area and volume (hence, mass) distributions of nanoparticle aggregates. The nanoparticle aggregate mobility analysis method has been recently incorporated in the Aerosol Instrument Manager® Software for TSI Model 3936 series SMPS. The software module may be used for post-processing of collected SMPS data, including data previously collected by older versions of Aerosol Instrument Manager software. The updated Aerosol Instrument Manager software (version 8.0) will be available starting October 1, 2006.
Existing SMPS customers may upgrade their Aerosol Instrument Manager software with the new nanoparticle aggregate mobility analysis module for a nominal fee.

**Note:** The nanoparticle aggregate mobility analysis software module is compatible with all (new and old) TSI model 3936 series component SMPS systems, however, cannot be used with TSI Model 3034 single box SMPS systems.

## References


Index

%  
% concentration  
   SMPS spectrometer, 4-33  

A  
accelerator keys, B-5  
Access database, SMPS data, 4-15  
active window, 1-2  
aerodynamic particle sizer spectrometer, 1-1  
aerosol electrometers, 1-1  
aerosol flow rate, 4-6  
append sample data to SMPS file, 4-14  
arrange windows, 3-11  
atention  
   icon, 4-43  
automatically export SMPS data to a database, 4-25  
automatically export SMPS data to a file, 4-25  
AutoPlay, 2-2  

B  
beginning sample, 4-40  

C  
calculations used, C-1  
change how data is displayed, 3-3  
change SMPS properties, 4-3  
channel resolution, 4-28  
charge correction  
   icon, 4-43  
classifier model, 4-6  
clear reference buffer, 4-41  
collecting sample data  
   SMPS spectrometer, 4-1  
color, 4-29  
color and font toolbar, 4-39  
comment, 4-11  
communications tab descriptions, 4-14  
concentration (dW)  
   SMPS spectrometer, 4-33  
condensation particle counter, 1-1  
connect to CPC, 4-24  
connect to SMPS database, 4-21  
copy, 4-39  
CPC  
   USB port, 2-2  
CPC model, 4-6  
cumulative conc.  
   SMPS spectrometer, 4-33  
cylindrical DMA measurements, 4-8  

D  
Dₜₐ of impactor, 4-7, 4-12  
data files, A-1  
data hotspot, select, 3-6  
Data Merge software  
   icon, 4-39  
   installation, 2-1  
   manual, xi  
defaults for air, 4-11  
delete/undelete sample, 3-6, 4-41  
desktop, 3-1  
diffusion correction, 4-11  
   icon, 4-43  
   option, 4-12  
diffusion loss correction, G-1  
disconnect from CPC, 4-24  
disconnect from SMPS database, 4-22  
display, 4-29  
display graph  
   showing area, 4-28  
   using bars, 4-28  
   using lines, 4-28  
   with horizontal and vertical grid, 4-29  
   with horizontal grid, 4-29  
   with vertical grid, 4-29  
display options for units, 4-33  
DMA model, 4-6  
down scan first, 4-7  
dW/dlogDp  
   SMPS spectrometer, 4-33  

E  
electrical aerosol detectors, 1-1  
ending sample, 4-40  
error messages, F-1  
example files, 3-2  
export data, 3-8  
   automatically, 3-10  
   manually, 3-9  
export file, 3-10  
Export Parameters screen, 3-9  
export SMPS data to Access database, 4-15  
extensions for SMPS spectrometer, 4-2  

F  
File menu, 4-19  
file parameters, A-1  
flow rate, 4-6  
font, 4-31  
Font dialog box, 4-31
format menu, 4-26
  channel resolution, 4-27
color, 4-29
font, 4-31
  style, 4-31
graph type, 4-28
grid lines, 4-29
undo zoom, 4-31
view boundaries, 4-28
Y axis, 4-27
format menu for SMPS graph, 4-27

G
gas viscosity, 4-10
Graph Color dialog box, 4-30
graph toolbar, 4-39
graph type, 4-28
grid lines, 4-29

H
hardware settings tab descriptions, 4-6
Help menu, 4-42
HV polarity, 4-6

I–J–K–L
icons
  playback, 3-4, 3-5
  status bar, 4-43
impactor geometric cut point, 4-12
impactor type, 4-6
impactor, D_50, 4-12
inlet flow rate, 4-6
installation, 2-2
  procedure, 2-1
  requirements, 2-1
instrument
  ID, SMPS Spectrometer, 4-11
introduction, 1-1

M
macroIMS, 4-37
Macroion Mobility Spectrometer, 4-37
main toolbar, 4-39
mean free path, 4-11
Model 3080 Classifier, 4-6
Model 3480C Charge-reduced Electrospray
  Ionization (ESI) Source, 4-37
Model 3934 SMPS
  manual, xi
Model 3936 SMPS
  manual, xi
Model 3980C macroIMS manual, xi
molecular mass, 4-37
multiple charge correction, 4-11

N
nanoparticle aggregate mobility analysis (continued)
  software module, H-1
navigation, 1-1
navigation toolbar, 4-39
negative high voltage controller, 4-6
next sample, 4-40
notations/conventions, 1-2
number of samples, 4-9
O
open an existing file, 3-2
organization, 1-2
P
particle density, 4-11
pause, 4-26
physical properties tab, 4-10
physical properties tab descriptions, 4-10
play, 4-26
playback data samples, 3-4
playback icons, 3-4, 3-5
Playback menu, 4-25
preview, print, 3-8
previous sample, 4-40
print information displayed, 3-8
Print Preview screen, 3-8
project files, A-1
properties of the SMPS spectrometer, 4-4
Q
quit the program, 3-12
R
raw counts, 4-33
raw data, 4-37
readme.htm file, 2-2
reference, 4-38
references, G-7, H-8
retrace, 4-9
review SMPS properties, 4-3
RS-232 serial interface port, 2-2
Run menu, 4-23
S
sample, 4-38
sample menu, 4-40
  beginning sample, 4-40
  clear reference buffer, 4-41
  delete/undelete sample, 4-41
  ending sample, 4-40
  next sample, 4-40
  previous sample, 4-40
  select all, 4-41
  select as reference, 4-41
sample/reference, 4-39
sample—reference, 4-38
Samples List window, 3-3
saved parameters, A-3
scan time, 4-7
scan up, 4-9
scanning mobility particle sizer spectrometer, 1-1
scans per sample, 4-9
scheduled, 4-9
scheduling tab, 4-8
scheduling tab descriptions, 4-9
select all, 4-41
select as reference, 4-41
sequence files, E-1
set to max range
  SMPS spectrometer, 4-7
set up SMPS properties, 4-3
settings, 4-38
sheath flow rate, 4-6
size data, 4-36
size range bounds, 4-7
slip correction, D-1
SMPS communications tab, 4-13
SMPS hardware settings tab, 4-5
SMPS menus
  format, 4-26
SMPS properties, 4-4
SMPS Properties screen, 4-10
SMPS Properties—New Sample screen, 4-5, 4-8,
  4-14
SMPS scheduling tab, 4-8
SMPS software comparison, D-1
SMPS spectrometer
  procedures, 4-1
SMPS spectrometer menus, 4-18
SMPS units, 4-32
SMPS weight options, 4-34
software
  license, vi
start at time, 4-9
start data collection, 4-3
start the program, 3-1
statistics, 4-37
statistics table, 4-37
status bar icons, 4-43
stop, 4-26

T
T-00 10 SMPS settings, 4-17
T-00 11 SMPS data, 4-18
T-00 12 SMPS Sample data, 4-18
T-00 header, 4-17
Table Color dialog box, 4-30
tables, Access database, 4-17
td, 4-6
tf, 4-6
title, 4-11
toolbars, 4-39
total sample time, 4-9
trigger file, 4-9
two-pane layout of an SMPS file, 3-11

U
unable to establish connection to the CPC, 4-3

units menu, 4-32
Units Selection menu screen, 4-32
unzoom, 3-7
USB port, 2-2

V
View Boundaries dialog box, 4-28
View menu, 4-32
copy, 4-39
molecular mass, 4-37
raw data, 4-37
reference, 4-38
sample, 4-38
sample/reference, 4-39
sample—reference, 4-38
settings, 4-38
size data, 4-36
statistics, 4-37
toolbars, 4-39
units, 4-32
weight, 4-34
View menu screen, 4-32
view multiple samples, 3-4
view SMPS boundaries, 4-28
voltage range, 4-7

W–X
warranty, v
weight, 4-34
Weight menu screen, 4-34
weight options, 4-35
Window menu, 4-41

Y
Y axis, 4-27
Y-axis dialog box, 4-27

Z
zoom in/zoom out, 3-7
Reader’s Comments

Please help us improve our manuals by completing and returning this questionnaire to the address listed in the “About This Manual” chapter. Feel free to attach a separate sheet of comments.

Manual Title  Aerosol Instrument Manager® Software for Scanning Mobility Particle Sizer™ (SMPS™) Spectrometer  P/N 1930038   Rev. G

1. Was the manual easy to understand and use?
   □ Yes      □ No

1. Please identify any problem area(s) __________________________________________________________
   _________________________________________________________________________________________________
   _________________________________________________________________________________________________

2. Was there any incorrect or missing information? (please explain) ________________________________
   _________________________________________________________________________________________________
   _________________________________________________________________________________________________

3. Please rate the manual according to the following features:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Good</th>
<th>Adequate</th>
<th>Poor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Readability</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accuracy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Completeness (is everything there?)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Organization (finding what you need)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quality and number of illustrations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quality and number of examples</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Comments: ___________________________________________________________________________________
   _________________________________________________________________________________________________
   _________________________________________________________________________________________________

4. Which part(s) of this manual did you find most helpful? ________________________________
   _________________________________________________________________________________________________
   _________________________________________________________________________________________________

5. Rate your level of experience with the product:
   □ Beginning      □ Intermediate      □ Expert

6. Please provide us with the following information:

   Name _______________________________  Address _______________________________

   Title _______________________________  _______________________________

   Company ____________________________  _______________________________